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1. About This Document

1.1 Version Information
This document provides information for installing, configuring, and using Vaisala Boundary
Layer View Software BL-View.

Table 1 Document Versions

Document Code Date Description

M211185EN-B June 2017 Release 2.0 contains the following new features:

• New algorithm
• 1-hour average mixing layer height
• NetCDF data files
• TCP/IP connection to ceilometer
• Visual update to UI

Removed features: BL-View PostgreSQL database.

M211185EN-A June 2010 First version of this manual.

This Vaisala Boundary Layer View Software BL-View User Guide is available as follows:

• BL-View 2.0 software contains the online help.
• USB drive contains the online and PDF help.

The help content is identical in the PDF and online.

1.2 Related Manuals

Table 2 Related Manuals

Document Code Name

M210482EN Vaisala Ceilometer CL31 User Guide

M210801EN Vaisala Ceilometer CL51 User Guide

Chapter 1 – About This Document
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1.3 Documentation Conventions

Warning alerts you to a serious hazard. If you do not read and follow
instructions carefully at this point, there is a risk of injury or even death.
WARNING!

Caution warns you of a potential hazard. If you do not read and follow
instructions carefully at this point, the product could be damaged or important data
could be lost.

CAUTION!

Note highlights important information on using the product.

Tip gives information for using the product more efficiently.

Lists tools needed to perform the task.

Indicates that you need to take some notes during the task.

1.4 Trademarks
Vaisalaâ is a registered trademark of Vaisala Oyj.

Microsoftâ and Windowsâ are either registered trademarks or trademarks of Microsoft
Corporation in the United States and other countries.

All other product or company names that may be mentioned in this publication are trade
names, trademarks, or registered trademarks of their respective owners.
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2. Vaisala Boundary Layer
View Software BL-View

Vaisala Boundary Layer View BL-View is a software application for planetary boundary layer
analysis and visualization. It is an independent data collection, storage, analysis, and
presentation tool designed for use with Vaisala Ceilometers CL31 and CL51. This affordable
package enables automatic 24/7 monitoring and visualization of the mixing layer height
(MLH) in all conditions to improve air quality monitoring and forecasting.

Figure 1 Vaisala Boundary Layer View Software BL-View

Improved Decision Making with Accurate Boundary Layer Visualization

The planetary boundary layer height, also known as the mixing layer height (MLH), is a key
parameter in the characterization of air pollution, together with urban emission source
strengths, traffic emissions, and weather influences. Because emissions and other near-
surface pollutants are diluted in a vertical direction within the planetary boundary layer,
monitoring the MLH is critical for estimating the nature, transformation, and removal of
pollutants. It is also a necessary parameter for the verification of numerical air pollution
simulations.

BL-View generates an online visual representation of the MLH that provides you with an
immediate understanding of local conditions. The MLH data can also be seamlessly
integrated into numerical weather prediction models. You can view and analyze logged data
while logging and displaying real-time data. The insights enabled by BL-View help to
improve your air quality monitoring and forecasting.

Chapter 2 – Vaisala Boundary Layer View Software BL-View
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Reliable Data Whatever the Weather

Vaisala Ceilometer measures the backscatter profile of the atmosphere and provides the
profile for analysis on BL-View. The software features an automatic algorithm for online
retrieval of boundary layer depth and additional residual structures. BL-View calculation is
based on combined gradient and idealized backscatter methods and enables reliable
automatic reporting of the convective mixing layer height (MLH). The algorithm also takes
into account time of day and location in order to improve automatic reporting in all
conditions.

The layer that is most relevant for air quality is reported as the MLH. Under normal
conditions this layer follows the convective layer. But in some cases if a strong additional
layer forms inside the convective layer, that layer will be reported as the MLH due to the fact
it traps all emissions and therefore is the most relevant for air quality. To ensure reliable
reporting in all weather conditions, BL-View also uses an all-weather algorithm that takes
into account possible precipitation and cloud events.

Fast Data Analysis

Vaisala BL-View is compatible with PCs running Microsoft Windowsâ and features a user-
friendly graphical interface. Communication between the ceilometer and PC is via an
Ethernet or serial line, and ceilometer messages are stored in netCDF format on the PC’s
hard drive. This format enables easy and fast data analysis and sharing. The automatically
analyzed boundary layer data is stored in log files that can be easily transferred to other
applications, for example as inputs to numerical weather prediction models.

Flexible User Interface

The ceilometer backscatter profile data is automatically analyzed by default parameters in
order to report the convective mixing layer height (MLH) and other boundary layer
structures such as residual boundary layer heights. In addition to real-time MLH reporting,
the software also reports the hourly average MLH.

It is also possible to run simultaneous operator-specific analyses with user-set algorithm
parameters. The stored profiles can be re-analyzed using any user-set parameters without
interfering with the real-time data analysis and visualization.

The clear graphical user interface allows easy and convenient multiprocessing. Operators
can zoom in on any point in a detailed analysis. The ceilometer and communication status is
permanently displayed on the main screen so that possible operational warnings and alarms
can be investigated. These warnings and alarms are also stored automatically to log files for
easy retrieval.

2.1 Supported Ceilometers
BL-View supports a single Vaisala Ceilometer CL31 or CL51.

BL-View User Guide M211185EN-B
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2.2 Minimum System Requirements

Table 3 Minimum System Requirements

Component Minimum Requirement

Computer Ethernet port, serial port, or USB serial converter

Operating system Windows 10 Pro

Windows 10 Pro Enterprise

Windows 7 Ultimate (32-bit or 64-bit)

Windows 7 Professional (32-bit or 64-bit)

RAM 2 GB

Hard disk space For BL-View installation: 600 MB

For BL-View data files: 4 … 4.5 GB / year (typically)

2.3 Licensing
BL-View requires a software license to run. To activate the license, you need a product key.

Vaisala delivers the product key when you purchase the software. If you have purchased the
software and you have not received the product key, contact Vaisala.

The license is mapped to the hardware. If your hardware changes and you need to re-install
BL-View, you must request a replacement license from your Vaisala representative.

Vaisala License Manager is used for activating the Vaisala software license.

The license allows one activation.

Chapter 2 – Vaisala Boundary Layer View Software BL-View
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3. Operating Principle
The planetary boundary layer (or atmospheric boundary layer) is the lowest part of the
Earth's atmosphere. It is directly influenced by its contact with the Earth's surface. The
planetary boundary layer responds to heat transfer, pollutant emission, and other surface
forcings in a timescale of an hour or less.

The depth of the planetary boundary layer depends on, for example, the location, season,
time of day, and weather. Typically, the planetary boundary layer extends 50 … 3000 m
(164 ... 9843 ft) from the Earth's surface. Fog, haze, mist, smog, and air pollution are typical
phenomena in the planetary boundary layer.

The planetary boundary layer contains several layer types:

• Convective boundary layer: Layer of air in which particles mix well due to mechanical
and thermal forces. The depth of the convective boundary layer is called the mixing
height.

• Nocturnal boundary layer: Stable layer of air that forms around sunset. Its top is often
marked by a temperature inversion. The layer usually dissolves by convection in the
morning hours, but it can also stay during daytime when solar heating is not sufficient
to disperse the nocturnal boundary layer.

• Residual layer: Layer of air containing the particles left from the previous convective
boundary layer after sunset or from long-range transportation by winds.

• Surface layer: Layer of air that is situated closest to the ground. Its thickness is typically
50 ... 100 m (164 ... 328 ft), about 10 % of the boundary layer height.

3.1 Diurnal Variation in Planetary
Boundary Layer

Variations that occur during the day in the planetary boundary layer are called diurnal
variation.

The following phenomena affect the formation of the component layers:

• Solar radiation heats the Earth's surface, causing thermals of warm air to rise from the
ground.

• Radiative cooling from the clouds at the top of the planetary boundary layer creates
thermals of cool air that sink down.

• Wind shear across the top of the convective boundary layer contributes to the
generation of turbulence.

During the day, diurnal variation has the following effects on the planetary boundary layer:

1. The turbulence in the air is caused by solar radiation and radiative cooling, both of
which occur simultaneously. At night, the radiative cooling of the surface controls the
boundary layer, creating the nocturnal layer. The nocturnal layer blocks the interference
between the surface layer and the residual layer. Before sunrise, the nocturnal boundary
layer height is the mixing height.

Chapter 3 – Operating Principle
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2. After sunrise the solar radiation destabilizes the situation on the surface, creating
thermals of warm air that rise upwards. The thermals continue to rise until their
temperature has dropped to the same temperature as the surrounding air.
At the same time thermals of cool air sink down from the top of the clouds. The
resulting turbulence causes heat, moisture, and particles to mix uniformly in the
convective boundary layer. The convective boundary layer reaches its maximum mixing
height in the late afternoon.
The entrainment zone acts as an interface between the convective boundary layer and
free atmosphere. Turbulent air from above is mixed into the convective boundary layer
in this region of the atmosphere.
When the convective boundary layer reaches the level of the residual boundary layer,
both layers are mixed together. This is an important process for air pollution
transportation in time and space. The horizontal dispersion and transportation have a
strong influence on the air quality.

3. When the sun sets, radiative cooling causes the convective boundary layer to collapse.
A new nocturnal boundary layer is formed, and it is again replaced with a new
convective boundary layer during the next day.

Figure 2 Planetary Boundary Layer Structure and Diurnal Variation

3.2 Boundary Layer Analysis
A ceilometer sends out short, powerful laser pulses in a vertical or near-vertical direction.
The light reflection caused by haze, fog, mist, virga, precipitation, aerosols, and clouds,
known as backscatter, is measured as the laser pulses traverse the sky.
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The backscatter profile, that is, the signal strength versus the height, is stored and
processed, and the data is used to calculate the cloud bases and the planetary boundary
layer structure.

The planetary boundary layer is the portion of the lower atmosphere where wind,
temperature, and moisture are strongly influenced by the Earth’s surface. The depth of this
layer, also known as the mixing height layer, is important for analyzing the state of the
atmosphere, for example, for air quality evaluation and aviation.

The backscatter signal is typically stronger in the planetary boundary layer where particle
concentration is higher, but weaker in the free atmosphere where the atmosphere typically
has fewer particles. BL-View detects the backscatter gradient between the planetary
boundary layer and free atmosphere (the mixing height), as well as other atmospheric
structures, such as residual boundary layers and elevated smoke or aerosol plumes that may
produce strong backscatter gradients.

To reduce sensitivity to noise and transient details in atmospheric structure, BL-View
performs vertical and temporal averaging on the ceilometer data.

Figure 3 Backscatter Profile from Convective Boundary Layer

3.3 Mixing Height Algorithm
BL-View uses 3 different algorithm methods:

Chapter 3 – Operating Principle
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• Gradient
• Profile fit
• Merged gradient and profile fit

Gradient Method

The gradient method can detect up to 3 aerosol layers and performs well in many situations,
particularly for shallow nocturnal boundary layers (less than 500 m / 1640 ft above ground
level).

Profile Fit Method

The profile-fit method detects only a single layer, and successfully estimates mixing heights
when the aerosol backscatter signal is weak, local gradients are weak and diffuse, and the
boundary layer evolves rapidly with time during morning and evening transitions.

Merged Gradient and Profile Fit Method

The merged gradient and profile fit method merges the strengths of the gradient and profile
fit methods, but retains the ability to detect multiple layers in a backscatter profile. The
merged method uses the following rules to select the mixing height from the gradient and
profile-fit retrievals:

• The gradient method’s lowest retrieval for cloud profiles and shallow, high quality
boundary layers.

• Profile-fit retrieval in all other cases (the gradient method's lowest retrieval is not
displayed unless it differs by more than 1000 m / 3281 ft).

• Second and third gradient retrievals are displayed in all cases, as they may indicate
residual layers or other aloft aerosol layers.

The algorithm identifies reliably the various boundary layers, such as the nocturnal,
convective, marine, and residual layers, and differentiates the mixed layer from other aerosol
layers detected by BL-View. It also provides an outlier removal method, cloud filter, and
other changes to improve performance for evening boundary layer transitions and to
increase flexibility and robustness for handling data from both CL31 and CL51 ceilometers.

The algorithm determines the mixing height by fitting an idealized backscatter profile to
observed range-corrected ceilometer backscatter profiles. Clouds and precipitation produce
backscattering profiles that deviate substantially from an idealized profile, which results in
poor mixing height estimates. The algorithm can produce valid retrievals even if the
backscatter profile deviates significantly from the idealized profile.

When a ceilometer detects multiple aerosol layers, the algorithm attributes one aerosol layer
as the mixing height. When there are multiple aerosol layers present, the lowest layer is a
reasonable first guess for attributing one of these layers as the mixing height.

More Information

‣ Creating Calculation Presets (page 63)
‣ Modifying Calculation Presets (page 65)
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3.3.1 Cloud and Precipitation Filter
Cloud filters prevent spurious mixing height retrievals caused by clouds or precipitation in
the backscatter profiles, especially below 4000 m (13 123 ft) above ground level.

• In the gradient method, clouds and precipitation produce strong local gradients that
may be unrelated to the mixing height.

• In the profile-fit method, clouds and precipitation produce backscattering profiles that
deviate substantially from an idealized profile, which result in poor mixing height
estimates.

The cloud filter significantly improves the mixing height estimate, and eliminates retrievals in
the morning when there are clouds and strong backscatter near the ground.

The algorithm does not report a mixing height when one or more of the following
circumstances exists:

1. Clouds are present below 160 m (525 ft) above ground level.
2. Precipitation or excessively high backscatter are detected in the backscatter profile.
3. Clouds are present below 4000 m (13 123 ft) above ground level and there is excessive

backscatter below 1000 m (3280 ft). Retrievals are still allowed when there are shallow,
non-precipitating clouds below 4000 m (13 123 ft), but above 160 m (525 ft).

3.3.2 Variable Averaging
Long averaging intervals help prevent false gradient minima hits generated by signal noise.
However, this approach reduces the ability of the algorithm to respond to short scale signal
fluctuations in space and time. The amount of signal noise depends on the range and time of
the day. The gradient method provides variable averaging parameters.

BL-View default settings use 80-m (262-ft) height averaging close to the ground. This
interval is gradually increased to 360-m (1181-ft) averaging used at heights above 1500 m
(4921 ft).

The selected time averaging interval depends on the signal noise. It varies between
14 minutes during night-time and 52 minutes on a bright, cloudy day.

3.3.3 Variable Threshold
Small density fluctuations within a convective boundary layer with a high aerosol load can
have lower gradient values than the top of the layer in dry rural surroundings.

BL-View prevents the reporting of these fluctuations as the top of the aerosol layer by using
variable threshold values that depend on the average backscatter signal from the boundary
layer. A local gradient minimum is only reported if its value is below the threshold.

3.3.4 Outlier Removal
Removing outliers filters spurious mixing height retrievals that are caused by instrument
noise, transient small-scale aerosol features, or other artifacts that cannot be removed by
traditional averaging techniques. However, this retains important details of the boundary
layer evolution throughout the day.

Chapter 3 – Operating Principle
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To avoid removing valid mixing heights, the algorithm relaxes the figure-of-merit criteria for
distinguishing valid retrievals from outliers. For each retrieval, the outlier removal method
computes a figure-of-merit score based on proximity (in height) to other retrievals in the
preceding four minutes. The algorithm deems retrievals with an insufficient number of
neighbors (a low figure-of-merit score) as outliers and replaces them by the most recent
valid retrieval.

3.4 Impact of Weather Conditions
The following weather conditions have an impact on the analysis of planetary boundary
layer structure.

Precipitation

During precipitation, mixing height or other aerosol layers cannot be reported. This is due to
the very high signal from precipitation dominating the backscatter from any remaining
aerosol layers, which makes it impossible to distinguish these from the precipitation.

Low-layer Clouds

Low-layer clouds appear at height 0 … 2000 m (0 ... 6562 ft). If there are low-layer clouds,
the mixing height is typically situated at the top of the clouds. In these conditions, BL-View
does not show the true mixing height due to the measurement principle of Vaisala
Ceilometer (LIDAR). In normal conditions, the deviation between the reported local gradient
minimum and the top of the cloud is typically less than 200 m (656 ft).

Mid-layer and High-layer Clouds

Mid-layer clouds appear at height 2000 … 5000 m (6562 ... 16 404 ft) and high-layer clouds
at height over 5000 m (16 404 ft). Mid-layer clouds and high-layer clouds do not typically
create any problems for mixing height measurement. The mixing height is reported normally
from the collected data.

Fog or Ground-based Obscuration

Fog or ground-based obscuration affects the mixing height measurement.

If the fog or ground-based obscuration is too dense, the laser light does not penetrate the
layer, which makes it extremely difficult to estimate the mixing height.

In these conditions, Vaisala Ceilometer typically reports the vertical visibility reading with
the highest altitude from which the backscatter signal can be received. If the signal is not
strong enough, the mixing height reading is reported automatically.

BL-View User Guide M211185EN-B
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4. Installation
If you are installing BL-View to a computer that has a previous version of BL-View, perform
the following procedures in the order presented.

1. 4.1 Backing up BL-View Data (page 17)
2. 4.2 Uninstalling BL-View (page 18)
3. 4.3 Installing BL-View (page 18)
4. (optional) 4.4 Preparing Files for Import (page 19)
5. (optional) 4.5 Importing Data (DAT files) (page 20)

For new installations, see 4.3 Installing BL-View (page 18).

4.1 Backing up BL-View Data

Back up all BL-View data before you uninstall the previous version of BL-View.

1. On your computer, select Start > Command Prompt.

2. To go to the BL-View PostgreSQL folder, type the following command: 

cd c:\BLView\Postgresql

3. To back up the BL-View database, type the following command: 

take_backup.bat <backup folder path>\<backup file name>

For example:

take_backup.bat c:\temp\blv_backup.dmp

The BL-View database is backed up and saved in the selected backup folder with a
given name.

To avoid losing data, do not save the backup file in the BL-View or BL-
View database installation folders (C:\BLView and C:\Postgresql).
CAUTION!

4. Close the command prompt.

Chapter 4 – Installation
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If you accidentally uninstall the database, reinstall it manually from the backup file.

4.2 Uninstalling BL-View

Before you uninstall BL-View, back up BL-View data.CAUTION!

1. Select Start > Control Panel.

2. Select Programs and Features.

3. In the Uninstall or change a program window, select BL-View > Uninstall.

4. Follow the instructions in the InstallShield Wizard.

4.3 Installing BL-View

Install BL-View on a computer that does not contain any previous version of
BL-View. Otherwise you may lose existing BL-View files.
CAUTION!

To perform installation on your computer, log in as an administrator.

Before you activate the BL-View license, make sure that your computer is connected to
the internet.

1. Insert the USB drive in a USB port on your computer. 
The BL-View installation program launches automatically in a few seconds. If the
installation does not launch automatically, double-click the executable (EXE) file on the
USB drive.

2. Follow the instructions in the InstallShield Wizard. 
Install BL-View to the following folder: C:\Program Files (x86).

3. To activate BL-View, follow the onscreen instructions in License Manager. Use the
product key from the cover letter.

4. To complete and verify the installation, restart your computer and open BL-View: Start 
> All Programs > Vaisala > BL-View > BL-View.

BL-View User Guide M211185EN-B
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If you choose to use the trial license, a 180-day trial license is activated. When you open the
application, it shows the number of days after which the trial expires.

More Information

‣ Licensing (page 9)

4.4 Preparing Files for Import
Before you import DAT files to BL-View, you can add information to the files and change the
message interval in the DAT files.

After import, you can view the information in BL-View.

More Information

‣ Importing Data (DAT files) (page 20)

4.4.1 Changing Ceilometer Identification Data in Import Files
Before you import DAT files to BL-View, you can add information to the files such as:

• Ceilometer name
• Latitude, longitude, and altitude information
• UTC offset

1. Go to the following folder on your computer: 
C:\Program Files (x86)\Vaisala\BL-View\config

2. Open the file level_one_import.ini in Notepad.

3. Make the changes to 2 locations in the file and select File > Save.

4.4.2 Changing Message Interval in Import Files
BL-View uses the 16-second message interval when plotting data.

If your DAT files contain data that has been logged with other than the 16-second interval,
you must change the settings of the DAT files. The conversion service needs the information
so that BL-View can display the data correctly.

1. Go to the following folder on your computer: 
C:\Program Files (x86)\Vaisala\BL-View\config

2. Open the file level_one_import.ini in Notepad.

Chapter 4 – Installation
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3. Change the instances information from: 

[__INSTANCES__]
L1_INPUT_AUTO=YES
L1_INPUT_USER_DEF=NO

to:

[__INSTANCES__]
L1_INPUT_AUTO=NO
L1_INPUT_USER_DEF=YES

4. Change the message interval information. 
The message interval of the DAT files must be 2 ... 75 seconds.
For example, if the DAT files were logged with the 30-second interval, change the
information from:

[L1_INPUT_USER_DEF]
DIRECTORY=[S]"LevelOneImport"
RUN_MODE=[S]"UserDefined"
    ; Message interval (2-75 seconds, default 16).
MESSAGE_INTERVAL=[I]16
    ; Time span of one DAT file (1-24 hours, default 6).
DAT_FILE_SIZE=[I]6

to:

[L1_INPUT_USER_DEF]
DIRECTORY=[S]"LevelOneImport"
RUN_MODE=[S]"UserDefined"
    ; Message interval (2-75 seconds, default 16).
MESSAGE_INTERVAL=[I]30
    ; Time span of one DAT file (1-24 hours, default 6).
DAT_FILE_SIZE=[I]6

5. Select File > Save.

4.5 Importing Data (DAT files)
Use the import service to import CL-VIEW DAT files to BL-View.
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• If the DAT files have been logged with other than the 16-second interval, see 4.4.2
Changing Message Interval in Import Files (page 19).

• If you want to add the ceilometer name, latitude, longitude, altitude, and UTC offset
information to the import files, see 4.4.1 Changing Ceilometer Identification Data in
Import Files (page 19).

1. Create a folder named LevelOneImport to the following location: 
C:\Program Files (x86)\Vaisala\BL-View\bin

2. Copy the files that you want to import to the folder that you created: 
C:\Program Files (x86)\Vaisala\BL-View\bin\LevelOneImport

3. Check that the file level_one_import.ini is in the following folder: 
C:\Program Files (x86)\Vaisala\BL-View\config

4. To open command prompt, select Start, right-click on Command Prompt and select
Run as administrator.

5. In command prompt, to go to the main level, type the following: 

cd C:\

6. To go to the folder that contains the application for running the import, type the
following: 

cd C:\Program Files (x86)\Vaisala\BL-View\bin

7. To restart the service, type the following: 

roaadmin.exe reload

8. To run the import, type the following: 

level_one_import.exe

The import can take a long time depending on the number of DAT files. The import
stops when all DAT files are processed.
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5. Configuration
BL-View is connected to a ceilometer through a serial line, TCP/IP, or USB connection.

When the BL-View installation is complete, the software starts to receive and analyze data
continuously even when the graphical user interface is not open.

Before using BL-View to view and analyze live data from the ceilometer:

1. Make sure that the ceilometer is connected to a computer.
See 5.1 Ceilometer Connection Settings (page 23).

2. Check that the ceilometer settings are correctly configured.
See 5.2 Configuring Ceilometer (page 25).

3. Add the location parameters of the ceilometer to BL-View.
See 5.3 Adding Ceilometer to BL-View (page 27).

4. Configure the BL-View communication settings.
See 5.4 BL-View Communication Settings (page 29).

When making changes to INI files, always restart the BL-View service with the
roaadmin.exe reload command.

5.1 Ceilometer Connection Settings
Before you can start using BL-View to view and analyze live data from the ceilometer, you
must establish a data connection between the ceilometer and a computer.

To do this, connect to the ceilometer server through a browser. See:

• 5.1.1 Entering TCP Client Mode (page 23)
• 5.1.2 Entering UDP Mode (page 24)

For more information, see Vaisala Ceilometer CL31 User Guide and Vaisala Ceilometer CL51
User Guide.

5.1.1 Entering TCP Client Mode

1. Select Operating Settings.

2. Select a port.
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3. In Operation Mode, select TCP Client Mode. 

4. In Destination IP address 1, type your destination address and port. 
You can add four destinations.

5. Select Submit.

5.1.2 Entering UDP Mode

1. Select Operating Settings.

2. Select a port.
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3. In Operation Mode, select UDP Mode. 

4. In Destination IP address 1, type your destination address and port. 
You can add four addresses.

5. Select Submit.

5.2 Configuring Ceilometer
If you have not ordered the ceilometer together with BL-View, you may need to change the
ceilometer settings before using BL-View to analyze live data from the ceilometer.

For optimum performance, use the recommended settings for the selected ceilometer
type.
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Setting Supported Values Recommended Value
for CL31

Recommended Value
for CL51

Data message msg1_10x770 msg2_10x770

If the Sky Condition
algorithm is disabled:

msg1_10x770

msg2_10x1540

If the Sky Condition
algorithm is disabled:

msg1_10x1540

msg1_20x385

msg1_5x1500

msg1_10x1540

msg2_10x770

msg2_20x385

msg2_5x1500

msg2_10x1540

Reporting interval 2 … 75 seconds 16 seconds 36 seconds

1. Open the connection to the ceilometer. 
See 9.1 Opening Terminal Connection (page 75).

2. Open the communication port to the ceilometer. 
See 9.2 Opening and Closing Communication Port (page 77).

3. To set advanced level commands, type the following command: 
advanced

4. To set the message format, type the following command: 
set message type <message format>
• For CL31: set message type msg2_10x770
• For CL51: set message type msg2_10x1540

5. To set the message interval, type the following command: 
set message interval <message interval>
• For CL31: set message interval 16
• For CL51: set message interval 36

6. To enable the range gate normalization, type the following command: 
set message profile noise_h2 on
The range gate data is always range-normalized, including the noise.

7. To get the factory parameters of CL31, type the following command: 
get params factory

8. Check the receiver type for CL31 in the response. If CLR321 appears as the receiver type,
go to the next step. Otherwise, change the algorithm parameters with the following
command: 
set factory algo_sensit high_cloud 5

9. Close the communication port. 
See 9.2 Opening and Closing Communication Port (page 77).

10. Verify that the output message is correct.
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5.3 Adding Ceilometer to BL-View
When you start BL-View the first time, add the ceilometer information to BL-View.

This information is used as parameters in the netCDF files.

1. Select Start > All Programs > Vaisala > BL-View > BL-View.

2. In BL-View, select Settings > Communication.
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3. Set the following: 
Name

Type a name for the ceilometer.

Latitude
Type the latitude coordinate of the ceilometer.
Give the coordinates according to the standard WGS84: -90.0000 ... 90.0000
degrees south, north.

Longitude
Type the longitude coordinate of the ceilometer.
Give the coordinates according to the standard WGS84: -180.0000 ... 180.0000
degrees west, east.

UTC offset
Select the time zone.

4. Select Save and OK.
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5.4 BL-View Communication Settings
The following connection types are available for connecting BL-View to the ceilometer: serial
line connection, UDP connection, and TCP/IP connection.

5.4.1 Configuring Serial Line Connection
Select the settings for serial communication with the ceilometer.

1. In BL-View, select Settings.
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2. In the Communication tab, set the following for the Connection: 
Connection type

Select Serial.

Message type
Select the ceilometer data message type. This value must match the message
format set for the ceilometer.

Setting Supported Values Recommended
Value for CL31

Recommended
Value for CL51

Data message msg1_10x770 msg2_10x770

If the Sky Condition
algorithm is disabled:

msg1_10x770

msg2_10x1540

If the Sky Condition
algorithm is disabled:

msg1_10x1540

msg1_20x385

msg1_5x1500

msg1_10x1540

msg2_10x770

msg2_20x385

msg2_5x1500

msg2_10x1540

Reporting interval 2 … 75 seconds 16 seconds 36 seconds

Message interval
Set the message interval in seconds. The available range is 2 ... 75. The default
value is 16.

Baud rate
Set the baud rate. The options are 9600, 19200, 38400, 57600, and 115200. The
default value is 9600.

Serial port number
Select a COM port to communicate with the ceilometer. The available range is
COM1 ... COM8.

Data bits
Set the number of data bits to use. The available range is 5 ... 9. The default value
is 8.

Stop bits
Set the number of stop bits to use. The available range is 0 ... 4. The default value
is 1.

Parity
Select the parity. The parity bit in each character can be set to None, Odd, Even,
Mark, or Space.
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3. Select Save and OK.

5.4.2 Configuring UDP Connection
Select the settings for UDP communication with the ceilometer.

1. In BL-View, select Settings.
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2. In the Communication tab, set the following: 
Connection type

Select UDP.

Message type
Select the ceilometer data message type. This value must match the message
format set for the ceilometer.

Setting Supported Values Recommended
Value for CL31

Recommended
Value for CL51

Data message msg1_10x770 msg2_10x770

If the Sky Condition
algorithm is disabled:

msg1_10x770

msg2_10x1540

If the Sky Condition
algorithm is disabled:

msg1_10x1540

msg1_20x385

msg1_5x1500

msg1_10x1540

msg2_10x770

msg2_20x385

msg2_5x1500

msg2_10x1540

Reporting interval 2 … 75 seconds 16 seconds 36 seconds

Message interval
Set the message interval in seconds. The available range is 2 ... 75. The default
value is 16.

Local port
Select the local port to match the setting in ceilometer.

Remote host
Select the remote host to match the setting in ceilometer.

Remote port
Select the remote port to match the setting in ceilometer.
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3. Select Save and OK.

5.4.3 Configuring TCP/IP Connection
BL-View supports remote connection to the ceilometer. Select the settings for the TCP/IP
communication with the ceilometer.

1. In BL-View, select Settings.
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2. In the Communication tab, set the following: 
Connection type

Select TCP Server.

Message type
Select the ceilometer data message type. This value must match the message
format set for the ceilometer.

Setting Supported Values Recommended
Value for CL31

Recommended
Value for CL51

Data message msg1_10x770 msg2_10x770

If the Sky Condition
algorithm is disabled:

msg1_10x770

msg2_10x1540

If the Sky Condition
algorithm is disabled:

msg1_10x1540

msg1_20x385

msg1_5x1500

msg1_10x1540

msg2_10x770

msg2_20x385

msg2_5x1500

msg2_10x1540

Reporting interval 2 … 75 seconds 16 seconds 36 seconds

Message interval
Set the message interval in seconds. The available range is 2 ... 75. The default
value is 16.

Local port
Select the local port to match the setting in ceilometer.
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3. Select Save and OK.
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6. Functional Description

6.1 Data Inputs
BL-View supports the following file types:

• Vaisala BL-View netCDF files
• Vaisala CL-VIEW DAT files

You can bring existing L2 and L3 netCDF files to BL-View using File Manager and open the
data for viewing in BL-View.

You can import existing DAT files to BL-View. For viewing the data in BL-View, the service
converts them to netCDF format.

Figure 4 BL-View Import Data

More Information

‣ Accessing netCDF Files (page 72)
‣ Adding Archive Plots (page 61)
‣ Importing Data (DAT files) (page 20)
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6.2 Operating Modes
You can view live and archive data in BL-View.

BL-View uses the 16-second message interval when plotting data.

The available altitude units are meters (m) and feet (ft).

6.2.1 Archive Data
You can access archive data from the ceilometer.

You can analyze the data according to a default or customized parameter set.

BL-View automatically stores the data to netCDF files.

Figure 5 BL-View Archive Data

More Information

‣ Adding Archive Plots (page 61)
‣ NetCDF Files (page 41)

6.2.2 Live Data
You can access real-time live data from the ceilometer.

As soon as you have connected BL-View to a ceilometer, BL-View starts to collect data that
is based on the default parameters. BL-View collects the data even when you are not using
BL-View. By default, BL-View processes the data according to the default rendering
parameters.
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You can create customized parameter sets. For these, BL-View stores the data when you
have the plot open.

BL-View automatically stores the data to netCDF files.

• The netCDF L1 data file contains level 1 (L1) raw data from the ceilometer.
• The netCDF L2 data file contains level 2 (L2) data that has gone through the

precalculation service and averaging.
• The netCDF L3 data file contains level 3 (L3) data that has gone through the calculation

service and includes all the data from the algorithms, including mixing layer height
values and quality index data.

Figure 6 BL-View Live Data and Data Outputs

More Information

‣ Adding Live Plots (page 59)
‣ Data Outputs (page 39)

6.3 Data Outputs
BL-View supports the creation of several file types.

6.3.1 Image Files
BL-View supports the creation of image files from onscreen data.

You can easily save the view in an image file.

The saved image displays information about the used algorithm.

More Information

‣ Taking Snapshots (PNG Files) (page 71)

6.3.2 HIS Files (ASCII)
HIS files are log files that contain level 3 data.

Chapter 6 – Functional Description

39



Table 4 Level 3 HIS Files

Property Description

CREATEDATE Time stamp in format YYYY-MM-DD hh:mm:ss (UTC)

UNIXTIME Time stamp (UNIX time)

CEILOMETER Ceilometer identifier

PERIOD Data update period in seconds (constant 16)

SAMPLE_COUNT Number of level 2 samples used to compute this
level 3

BL_HEIGHT_1 First boundary layer height candidate (meters) (-999
if no candidate)

BL_INDEX_1 Quality index for first boundary layer height candidate
(-999 if no candidate)

BL_HEIGHT_2 Second boundary layer height candidate (meters)
(-999 if no candidate)

BL_INDEX_2 Quality index for second boundary layer height
candidate (-999 if no candidate)

BL_HEIGHT_3 Third boundary layer height candidate (meters) (-999
if no candidate)

BL_INDEX_3 Quality index for third boundary layer height
candidate (-999 if no candidate)

CLOUD_STATUS Cloud detection status, 0 - 4

CLOUD_1 First cloud base (meters) or vertical visibility (meters)
(-999 if no cloud base or vertical visibility)

CLOUD_2 Second cloud base (meters) or highest received signal
in vertical visibility (meters) (-999 if no cloud base or
vertical visibility)

CLOUD_3 Third cloud base (meters) (-999 if no cloud base)

PARAMETERS Level 2 to level 3 algorithm parameters

The following is an example of a HIS file with custom parameters.

History file
CREATEDATE, UNIXTIME, CEILOMETER, PERIOD, SAMPLE_COUNT, BL_HEIGHT_1, 
BL_INDEX_1, BL_HEIGHT_2, BL_INDEX_2, BL_HEIGHT_3, BL_INDEX_3, CLOUD_STATUS, 
CLOUD_1, CLOUD_2, CLOUD_3, PARAMETERS
2010-06-01 00:00:00, 1275350400, DEVICE_1, 16, 187, 150, 3, -999, -999, -999, 
-999, 0, -999, -999, -999, 1_360_0_3000_10_30_4000_3
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Property Description/Value

CREATEDATE 2010-06-01 00:00:00

UNIXTIME 1275350400

CEILOMETER DEVICE_1

PERIOD 16

SAMPLE_COUNT 187

BL_HEIGHT_1 150

BL_INDEX_1 3

BL_HEIGHT_2 -999 (no candidate)

BL_INDEX_2 -999 (no candidate)

BL_HEIGHT_3 -999 (no candidate)

BL_INDEX_3 -999 (no candidate)

CLOUD_STATUS 0

CLOUD_1 -999 (no cloud base or vertical visibility)

CLOUD_2 -999 (no cloud base or vertical visibility)

CLOUD_3 -999 ( no cloud base)

PARAMETERS 1_360_0_3000_10_30_4000_3

More Information

‣ Exporting Data (HIS Files) (page 71)

6.3.3 NetCDF Files
Network Common Data Form (netCDF) is a set of software libraries and self-describing,
machine-independent data formats that support the creation, access, and sharing of array-
oriented scientific data.

The netCDF service in BL-View follows level 1 (L1), level 2 (L2), and level 3 (L3) data.
Measurement and calculation events that occur every 16, 30, or 36 second trigger the service
to read the L1, L2, and L3 fields, and write the data to the respective netCDF file.

The service creates 1 netCDF file for L1 data, 1 netCDF file for L2 data, and 3 for L3 data: 1
with default profile settings, 1 with customized profile settings, and 1 for archive data. The
service creates the files every 24 hours.

The extension of netCDF files is .nc. The files are stored in directory: C:\BLViewData.

To read the data and other necessary parameters to create the netCDF files, the service uses
the bl_calc_srv.ini configuration file.
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Table 5 Parameters of bl_calc_srv.ini File

Parameter Description Type Possible
Values

STATION_NAME Name of the measuring station.

STATION_NAME is used in the
netCDF file name.

String Any valid string

INSTRUMENT_IDENTIFIER Identifier for the ceilometer (for
example, CL31 or CL51)

Currently not in use.

String Any valid string

FREE_FORMAT Custom text.

FREE_FORMAT is used in the
netCDF file name.

String Any valid string

PATH Directory for storing netCDF files. String Any valid
directory path

If no file exists, the service creates the file along with the dimension, attribute, and variable
information that are required for writing data.

If the file exists, the service reads the unlimited time dimension to fetch number of records
present in the file, and reads and initializes variable information.

More Information

‣ NetCDF Example File (page 85)
‣ Accessing netCDF Files (page 72)
‣ Changing Storage Location of netCDF Files (page 72)

6.3.3.1 NetCDF L1 File Format

The netCDF L1 data file contains level 1 (L1) raw data from the ceilometer.

NetCDF L1 file names have the following format:

L1_<STATION_NAME>_YYYYMMDDHHMM_<FREE_FORMAT>.nc

Table 6 Fields of L2 File Names

Name Description

L1 Identification of the data level

STATION_NAME Ceilometer name that is defined in the netcdf_srv.ini file

YYYYMMDDHHMM UTC time

FREE FORMAT Text that is defined in the netcdf_srv.ini file

Example: L1_06610_201609290722
The following global attributes are used:
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• site_location
• instrument_type

Table 7 L1 Dimensions

Dimension Name Description

time Number of profiles

range Number of vertical bins

Table 8 NetCDF L1 Data File Fields

Variable Name Attributes Description

time Units =
days

Type =
double

Dimension
= time

axis = T

Units as days since 1970-01-01 00:00:00.000

name Dimension
= time

Data identifier (ceilometer name) as defined in Settings > 
Communication

range Dimension
= range

 

message_type Dimension
= time

Ceilometer data message type (11, 12, 13, 16, 21, 22, 23, or 26)

version Dimension
= time

Ceilometer version number

date_stamp Units =
days

Type =
double

Dimension
= time

axis = T

Measurement time stamp in textual form (yyyy-MM-dd
hh:mm:ss), expressed as units as days since 1970-01-01
00:00:00.000

period Dimension
= time

Sending frequency of ceilometer data message in
milliseconds.

The boundary layer height algorithm is optimized for
16 second message interval

tilt_angle Units =
degree

Type =
integer

Dimension
= time

Ceilometer tilt angle (0 ... 90 degrees).
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Variable Name Attributes Description

cloud_status Dimension
= time

0 = no significant backscatter/some obscuration but
determined to be transparent

1 = one cloud layer

2 = two cloud layers or full obscuration (vertical visibility and
highest signal detected)

3 = three cloud layers

4 = change cloud status to 2, reports vertical visibility and
highest signal

cloud_data Dimension
= time

Cloud bases or vertical visibility/highest signal detected
(meters or feet)

status_bits Dimension
= time

Ceilometer status bits (12 characters)

profile_scale Dimension
= time

Scaling parameter of ceilometer signal backscatter profile
(0 ... 9999, 100 = no scaling)

profile_resolution Dimension
= time

Resolution of ceilometer signal backscatter profile (5, 10, or
20 m (16, 33, or 66 ft), depending on the message type)

profile_length Dimension
= time

Number of samples in ceilometer signal backscatter profile
(385, 770, or 1540), depending on the message type

rcs_910 Dimension
= time, range

Ceilometer signal backscatter profile

Each sample is coded with a 20-bit HEX ASCII character set

6.3.3.2 NetCDF L2 File Format

The netCDF L2 data file contains level 2 (L2) data that has gone through the precalculation
service and averaging.

The profile is set to 4500 m (14 764 ft).

NetCDF L2 file names have the following format:

L2_<STATION_NAME>_YYYYMMDDHHMM_<FREE_FORMAT>.nc

Table 9 Fields of L2 File Names

Name Description

L2 Identification of the data level

STATION_NAME Ceilometer name that is defined in the netcdf_srv.ini file

YYYYMMDDHHMM UTC time

FREE_FORMAT Text that is defined in the netcdf_srv.ini file

Example: L2_06610_201609290722
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Table 10 L2 Dimensions

Dimension Name Description

time Number of profiles

range Number of vertical bins

Table 11 NetCDF L2 Data File Fields

Variable Name Attributes Description

time Units = days

Type = double

Dimension = time

axis = T

Units as days since 1970-01-01 00:00:00.000

name Dimension = time Data identifier (ceilometer name) as defined in
Settings > Communication

version Dimension = time Ceilometer version number

date_stamp Units = days

Type = double

Dimension = time

axis = T

Measurement time stamp in textual form (yyyy-MM-
dd hh:mm:ss), expressed as units as days since
1970-01-01 00:00:00.000

range Dimension = range  

period Dimension = time Sending frequency of ceilometer data message in
seconds

cloud_status Dimension = time 0 = no significant backscatter/some obscuration but
determined to be transparent

1 = one cloud layer

2 = two cloud layers or full obscuration (vertical
visibility and highest signal detected)

3 = three cloud layers

cloud_data Dimension = time Cloud bases or vertical visibility/highest signal
detected (meters or feet)

status_bits Dimension = time Ceilometer status bits (12 characters)

profile_length Dimension = time Number of samples in ceilometer signal backscatter
profile (450)

bs_std Dimension = time Standard deviation of ceilometer signal backscatter
profile, computed from height range 6210 ... 6700 m
or 7210 ... 7700 m (20 374 ... 21 982 ft or
23 655 ... 25 263 ft)

profile_data Dimension = time,
range

Ceilometer signal backscatter profile (10-m / 33-ft
resolution, 450 samples up to height of 4500 m /
14 764 ft)
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Variable Name Attributes Description

longitude Dimension = time Longitude of each measurement. Based on ceilometer
location as defined in Settings > Communication

latitude Dimension = time Latitude of each measurement. Based on ceilometer
location as defined in Settings > Communication

altitude Dimension = time Altitude above sea level

utc_offset Dimension = time UTC offset

6.3.3.3 NetCDF L3 File Format

The netCDF L3 data file contains level 3 (L3) data that has gone through the calculation
service and includes all the data from the algorithms, including mixing layer height values
and quality index data.

There are 3 different L3 file types:

• L3 default file: This file contains L3 data that uses the default preset for a live plot.
• L3 custom file: This file contains L3 data that uses a custom preset for a live plot.
• L3 archive file: This file contains L3 data from archive plots.

NetCDF L3 file names have the formats that are shown in the following table.

Table 12 Naming of NetCDF L3 Files

L3 File Type File Name

L3 with default profile settings L3_Default_<STATION_NAME>_YYYYMMDDHHMM_<ParameterKe
y>_<FREE_FORMAT>.nc

L3 with custom profile settings L3_Custom_<STATION_NAME>_YYYYMMDDHHMM_<ParameterKey
>_<FREE_FORMAT>.nc

L3 for archive plot L3_OFFLINE_<STATION_NAME>_YYYYMMDDHHMM_<ParameterKe
y>_<FREE_FORMAT>.nc

Table 13 Fields of L3 File Names

Name Description

L3 Identification of the data level

Default Identification of the L3 file type

Custom

OFFLINE

STATION_NAME Ceilometer name that is given in the netcdf_srv.ini file

YYYYMMDDHHMM UTC time

FREE_FORMAT Text that is defined in the netcdf_srv.ini file
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Name Description

ParameterKey Identification of the advanced algorithm settings

Example:
L3_DEFAULT_06610_201701160000_1_360_1_3120_10_30_4000_3_0_1_500_1
000_4000_60.nc
The following global attribute is used:

• site_location

Table 14 L3 Dimensions

Dimension Name Description

time Number of profiles

range Number of vertical bins

Table 15 NetCDF L3 Data File Fields

Variable Name Attributes Description

time Units =
days

Type =
double

Dimension
= time

axis = T

Units as days since 1970-01-01 00:00:00.000

name Dimension
= time

Data identifier (ceilometer name) as defined in Settings > 
Communication

bl_height_length Dimension
= time

Number of boundary layer height candidates found (0 ... 3)

date_stamp Units =
days

Type =
double

Dimension
= time

axis = T

Measurement time stamp in textual form (yyyy-MM-dd
hh:mm:ss), expressed as units as days since 1970-01-01
00:00:00.000

range Dimension
= range

 

period Dimension
= time

Sending frequency of ceilometer data message in seconds
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Variable Name Attributes Description

cloud_status Dimension
= time

0 = no significant backscatter/some obscuration but
determined to be transparent

1 = one cloud layer

2 = two cloud layers or full obscuration (vertical visibility and
highest signal detected)

3 = three cloud layers

cloud_data Dimension
= time

Cloud bases or vertical visibility/highest signal detected
(meters or feet)

bl_index Dimension
= time

Quality indices for boundary layer height candidates

bl_height Dimension
= time

Boundary layer height candidates (meters)

bs_profile_length Dimension
= time

Number of samples in ceilometer signal backscatter profile
(450)

bs_profile_data Dimension
= time, range

Ceilometer signal backscatter profile (10-m / 33-ft resolution,
450 samples up to height of 4500 m / 14 764 ft)

ng_profile_length Dimension
= time

Number of samples in negative gradient profile (450)

ng_profile_data Dimension
= time, range

Negative gradient profile (10-m / 33-ft resolution, 450
samples up to height of 4500 m / 14 764 ft)

ec_profile_length Dimension
= time

 

ec_profile_data Dimension
= time, range

 

ec_profile_range Dimension
= time

 

ec_profile_opacity Dimension
= time

 

vrb_height_averaging Dimension
= time

True = Use variable height averaging (default)

False = Use user-defined constant height averaging

vrb_time_averaging Dimension
= time

True = Use variable time averaging (default)

False = Use user-defined constant time averaging

height_averaging_para
m

Dimension
= time

Height averaging parameter (40 ... 600 m, default 360 m /
131 ... 1969 ft, default 1181 ft)

Used only if vrb_height_averaging = false

time_averaging_period Dimension
= time

Time averaging period (60 ... 3000 seconds, default 3000)

Used only if vrb_time_averaging = false

algorithm_sensitivity Dimension
= time

Algorithm sensitivity (0 ... 20, default 10)

Smaller value means higher sensitivity

boundary_layer_min Dimension
= time

Minimum height for a boundary layer height candidate
(30 ... 500 m, default 30 m / 98 ... 1640 ft, default 98 ft)
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Variable Name Attributes Description

boundary_layer_max Dimension
= time

Maximum height for a boundary layer height candidate
(200 ... 4000 m, default 4000 / 656 ... 13 123 ft, default
13 123 ft)

number_of_boundary_la
yers

Dimension
= time

Maximum number of boundary layer height candidates to be
reported (1 ... 3, default 3)

location_lat Dimension
= time

Latitude of each measurement. Based on ceilometer location
as defined in Settings > Communication

location_lon Dimension
= time

Longitude of each measurement. Based on ceilometer
location as defined in Settings > Communication

location_utc_offset Dimension
= time

UTC offset of each measurement. Based on ceilometer
location as defined in Settings > Communication

algorithm_method Dimension
= time

 

parameter Dimension
= time

 

sunrise_utc Dimension
= time

 

sunset_utc Dimension
= time

 

Mean_Layer_Height Dimension
= time

Mean mixing layer height for the period of 1 hour

Mean_Layer_QualityInd
ex

Dimension
= time

Mean mixing layer quality index for the period of 1 hour

Mean_Layer_Calculatio
n_time

Dimension
= time

Mean layer calculation time for 1-hour interval

More Information

‣ NetCDF Example File (page 85)
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7. Using BL-View
BL-View offers different views to data, for example backscatter and negative gradient views,
and it is easy to filter out data to focus on only boundary layer height, cloud data height,
and/or intensity information. BL-View plots the boundary layer and cloud base data
according to specified settings. Use the live and archive plot options and adjust the
algorithm settings (calculation presets).

7.1 Opening BL-View
1. To open BL-View, select Start > All Programs > Vaisala > BL-View > BL-View. 

BL-View opens and shows live real-time data.

7.2 Reading Graphs
In BL-View, the boundary layer information is illustrated on the screen as density plots. You
can create plots to view and analyze live and archive data. Each new plot opens as a new
tab.

The panel on the right displays the following information:

• Navigator shows which section of the plot is currently displayed.
• For live plots: Current values shows the boundary layer and cloud base height in the

density plot that is currently open.
• For archive plots: Legend shows the boundary layer and cloud base markers. Height

information is not available.
• Intensity shows the intensity scale for the displayed boundary layer information in

backscatter or negative gradient view.
• Information shows the selected algorithm parameters and the update status.
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Figure 7 BL-View Panel: Live Plot

Figure 8 BL-View Panel: Archive Plot

7.2.1 Reading Boundary Layer and Cloud Detection Graphs
The Current values information shows the most recent height information for each
boundary layer and cloud base that are visible in the graph area.
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You can enable/disable Layer height and Cloud base height to show and hide the
information on the display.

1. To read boundary layer and cloud base height data, see the Current values panel. 
The information includes:

• Mixing layer: the height of the mixing layer
• 1-hour average: 1-hour average mixing layer height. The information is updated

every hour.
• Elevated layer 1 and Elevated layer 2: elevated aerosol layers
• Cloud base height: height of cloud base 1, 2, and 3

If a valid parameter is not correctly measured, its value is replaced with 2 slash
characters (//).

1 Sunset indicator (black)
2 Boundary layer heights (dark red/yellow/green) and elevated layers (gray)
3 Sunrise indicator (yellow)
4 Cloud base heights (blue dots)
5 Signal from clouds and precipitation (red)
6 Aerosol backscatter signal (light blue to yellow)
7 1-hour average mixing layer height (blue lines)
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2. To view only boundary layer height and cloud base height information, disable
Intensity. 

The following markers are used in the graphs:

• Dark red/yellow/green rectangles: Boundary layer heights. The colors indicate the
quality of the data.

• Blue lines: 1-hour average mixing layer height.
• Gray rectangles: Additional boundary layer heights (elevated layers).
• Blue dots: Cloud base heights.

7.2.2 Reading Cloud Intensity Graphs
The Intensity information indicates the intensity of the backscatter or negative gradient
signal.
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You can enable/disable Intensity to show and hide the information on the display. When
enabled, you can view intensity in Backscatter or Negative gradient.

1. In the Intensity panel, make sure that you have enabled Intensity. 

2. To view only layer height and intensity information without cloud base information,
disable Cloud base height. 

7.2.3 Using Backscatter View
You can choose to view ceilometer data in BL-View in the Backscatter view.
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Use the backscatter view for general analysis of the planetary boundary layer structure. The
colors in the intensity legend indicate the intensity of the backscatter signal in units of
10-9 m-1 sr-1.

For live data, the backscatter profile updates every minute.

1. In the Intensity panel, make sure that you have enabled Intensity.

2. In the Intensity panel, select Backscatter. 
The following figure shows an example of the backscatter view.

The backscatter view uses the following colors:

• Red in the plot: Signal from clouds and precipitation.
• Light blue to yellow in the plot: Aerosol backscatter signal.

The algorithm settings do not affect the displayed cloud base heights because these
calculations are performed in the ceilometer.

Fixed logarithmic scaling provides optimal signal dynamics and makes it easier to compare
the results from different days.

The backscatter view shows profiles that are rendered with the selected algorithm
parameters. The cloud and precipitation filter is always applied.

More Information

‣ Managing Plots (page 59)
‣ Managing Calculation Presets (page 63)
‣ Cloud and Precipitation Filter (page 15)
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7.2.4 Using Negative Gradient View
You can choose to view ceilometer data in BL-View in the Negative gradient view.

Use the negative gradient view for detailed analysis of the mixing height.

1. In the Intensity panel, make sure that you have enabled Intensity.

2. In the Intensity panel, select Negative gradient. 
The following figure shows and example of the negative gradient view.

The negative gradient view uses the following colors:

• Red in the plot: Strong signal decrease in clouds or precipitation.
• Light blue to yellow in the plot: Negative gradient signal.

The colors in the intensity legend indicate the intensity of the negative gradient signal in
arbitrary internal units. This gives a better view on all local gradient minima than showing a
gradient density plot.

Not all local gradient minima qualify as boundary layer heights.

More Information

‣ Managing Plots (page 59)
‣ Managing Calculation Presets (page 63)
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7.3 Managing Display Settings
You can select whether the data in BL-View is shown in meters or feet, and adjust the time
range on the horizontal axis and the height range on the vertical axis.

1. Select Settings > Display.

2. Set the following display settings: 
Default units

Select whether you want to display the data in meters or feet.

Time range
Select the time range (in hours) for the data displayed on the screen: 3, 6, 9, 12,
15, 18, 21, or 24 hours.
When the time range is 9 hours or less, the grid displays all hours in the selected
range. When the time range is 12 hours or more, the grid displays every third hour
of the selected range.

Height range
Select the maximum height that is displayed for the plot: 1000, 3000, or 4000 m
(5000, 10000, or 13000 ft).

3. Select OK. 

The new settings are not applied to the currently active plot. To create a plot with
the modified settings, select Add Plot.
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In addition, you can:

• Use your mouse to zoom in and out. Zooming is limited to 3 hours and 200 m (656 ft).
• Right-click in the graph area and select Refresh to refresh the view, Grid to hide or

show the grid, Plot properties to change time or height range, or Fit view to zoom
out.

More Information

‣ Adding Live Plots (page 59)
‣ Adding Archive Plots (page 61)

7.4 Managing Plots
A density plot is the graph that visualizes ceilometer data in BL-View.

You can manage plots in several ways.

7.4.1 Adding Live Plots
You can create density plots to view real-time data from the ceilometer.

You can only view 1 default live plot and 1 custom live plot simultaneously.

1. Select Add Plot > Live.
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2. Set the following properties: 
Preset

Select the preset (set of algorithm parameters) for analyzing the data.

Time range
Select the time range (in hours) for the plot: 3, 6, 9, 12, 15, 18, 21, or 24 hours.
This property is only available for live plots.

Height range
Select the maximum height that is displayed for the plot: 1000, 3000, or 4000 m
(5000, 10000, or 13000 ft).

3. Select OK. 

There can be a 1-minute delay before the live data is shown in BL-View.

The plot opens with the following name: Live-<name of preset>-PLOT. Live plots have a
green circle in front of the name.

More Information

‣ Live Data (page 38)
‣ Managing Calculation Presets (page 63)

7.4.1.1 Changing Overlap Correction Factors

To adjust the near-range performance of a ceilometer, edit the file
overlap_correction_profile.dat.

The overlap correction factor affects the default live plot.

1. On your computer, go to the following folder: 
C:\Program Files (x86)\Vaisala\BL-View\config
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2. Open the file overlap_correction_profile.dat in Notepad and edit the
information. 
The overlap correction factor is used to multiply the backscatter value at the specified
height in level 2 (L2) profile. Here is an example of how to change the overlap
correction factor for 10 m (3 ft 3 in) from 1.02 to 1.00.
Original settings:

TERENO Fendt correction factors
1.3    Version of this correction file
1.2    Sensitivity correction factor

Overlap correction factors
1.02        10 m
1.01        20 m
1.01        30 m
1.02        40 m
...

Modified settings:

TERENO Fendt correction factors
1.3    Version of this correction file
1.2    Sensitivity correction factor

Overlap correction factors
1.00        10 m
1.01        20 m
1.01        30 m
1.02        40 m
...

Above 360 m (1181 ft), the overlap correction factor is 1.0.

3. Save and close the file.

7.4.2 Adding Archive Plots
You can create density plots to view archived data.

1. Select Add Plot > Archive.
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2. Select a date in the calendar. 

3. Set the following properties: 
Preset

Select the preset (set of algorithm parameters) for analyzing the data.

Height range
Select the maximum height that is displayed for the plot: 1000, 3000, or 4000 m
(5000, 10000, or 13000 ft).

4. Select OK.

The plot opens with the following name: <date>-<name of preset>-PLOT. Archive plots have
a gray circle in front of the name.

More Information

‣ Archive Data (page 38)
‣ Managing Calculation Presets (page 63)

7.4.3 Modifying Plots
You can change the time and height range settings of the plot that you are viewing.

1. Select the tab for the plot you want to modify.

2. Select Plot properties.
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3. Modify the properties. 
Time range

Select the time range (in hours) for the data displayed on the screen: 3, 6, 9, 12,
15, 18, 21, or 24 hours.

Height range
Select the maximum height that is displayed for the plot: 1000, 3000, or 4000 m
(5000, 10000, or 13000 ft).

4. Select OK. 
The new properties are applied to the plot immediately.

5. You can also show/hide the grid and refresh the view. To show/hide the grid and refresh
the view, right-click on the plot and select Grid or Refresh.

7.5 Managing Calculation Presets
A preset is a set of algorithm parameters that are used in the calculations. For live plots, the
Information panel shows the preset values of the currently open density plot.

You can manage the calculation presets in several ways.

Figure 9 BL-View Algorithm Settings

7.5.1 Creating Calculation Presets
You can create calculation presets to use in plots.

1. Select Settings > Presets.
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2. To create a new preset, select Create new, type a name, and select OK. 
In the Settings window, set the following:

Algorithm method
Select Merged Gradient and profile fit, Gradient, or Profile fit.

Advanced algorithm settings
For information about modifying advanced algorithm settings, see 7.5.3
Modifying Algorithm Settings of Calculation Presets (page 67).

Boundary layer min
Set the lowest reported boundary layer height. The available range is 0 … 500 m
(0 … 1640 ft). The default value is 0 m (0 ft).

Boundary layer max
Set the highest reported boundary layer height. The available range is
200 … 4000 m (656 ... 13120 ft). The default value is 4000 m (13120 ft).

Number of boundary layers
Set the maximum number of boundary layers shown in BL-View. The available
range is 1 … 3. The default value is 3.

Time averaging
Select defined by User and set the time averaging interval. The default value is
30 minutes.

Height averaging
Select defined by User and set the height averaging interval. The default value is
360 m (1181 ft).
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3. Select Save and OK. 

Selecting only OK does not save the settings.

More Information

‣ Mixing Height Algorithm (page 13)

7.5.2 Modifying Calculation Presets
You can modify values of calculation presets, reset presets to default values, and delete
presets.

1. Select Settings > Presets.

2. Select a preset from the list on the left. 

You cannot modify the Default preset.
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3. Select one of the following:

• To reset the settings to default values, select Reset.
• To delete a preset, select Delete.
• To modify the algorithm settings, see 7.5.3 Modifying Algorithm Settings of

Calculation Presets (page 67).
• To modify an existing preset, edit the values:

Boundary layer min
Set the lowest reported boundary layer height. The available range is
0 … 500 m (0 … 1640 ft). The default value is 0 m (0 ft).

Boundary layer max
Set the highest reported boundary layer height. The available range is
200 … 4000 m (656 ... 13120 ft). The default value is 4000 m (13120 ft).

Number of boundary layers
Set the maximum number of boundary layers shown in BL-View. The available
range is 1 … 3. The default value is 3.

Time averaging
Select defined by User and set the time averaging interval. The default value
is 30 minutes.

Height averaging
Select defined by User and set the height averaging interval. The default value
is 360 m (1181 ft).
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4. Select Save > OK. 

Selecting only OK does not save the settings.

The changes are reflected in the Information panel for those plots that use the
modified preset.

More Information

‣ Mixing Height Algorithm (page 13)

7.5.3 Modifying Algorithm Settings of Calculation Presets
You can modify the algorithm settings for Merged Gradient and profile fit, Gradient, and
Profile fit.

The modifications apply to that preset only. Other presets that use the same algorithm
remain unchanged.

1. Select Settings > Presets.

2. Select a preset from the list on the left. 

You cannot modify the Default preset.

3. In Algorithm method, select the algorithm to modify, and select Edit.
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4. In Advanced Algorithm Settings, modify the settings: 

The number of settings to modify depends on the selected algorithm.

Algorithm sensitivity
Set the algorithm sensitivity. The available range is 0 … 20. The default value is 5.

SNR
Set the signal-to-noise ratio. The available range is 0 … 100. The default value is 1.

SNR average window
Set the average window for the signal-to-noise ratio. The available range is
20 … 1000 m (66 ...  3280 ft). The default value is 500 m (1640 ft).

Night profile length
Set the length of the night profile. The available range is 10 … 4500 m
(33 ... 14760 ft). The default value is 1000 m (3280 ft).

Day profile length
Set the length of the day profile. The available range is 10 … 4500 m
(33 ... 14760 ft). The default value is 4000 m (13120 ft).

Outlier removal strength
Set the outlier removal strength. The available range is 0 … 500. The default value
is 60.
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5. Select OK > Save > OK. 

Selecting only OK does not save the settings.
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8. Data Reporting
BL-View supports various data export formats to store data for use outside BL-View.

8.1 Taking Snapshots (PNG Files)
You can take snapshots to export the current plot as an image file (PNG).

1. In BL-View, select Snapshot.

2. Type a name for the image and select the directory where you want to save it.

3. Select Save. 
The saved image displays the date and information about the used algorithm at the top
of the image.
If you have zoomed in the density plot, the image contains the enlarged view.

More Information

‣ Image Files (page 39)

8.2 Exporting Data (HIS Files)
You can export archive ceilometer data from BL-View to HIS files. The files are in ASCII
format.

1. In BL-View, select Export data.
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2. In Preset, select the algorithm for analyzing the data.

3. In the calendar, select the date for the archived data and select OK.

4. Select one of the following:

• To view the data, select Open.
• To access the files later on, select Close.

The files are stored in the following directory: C:\BL-View\History.

More Information

‣ HIS Files (ASCII) (page 39)

8.3 Accessing netCDF Files
BL-View automatically stores live and archive data to netCDF files.

1. To access the netCDF files, go to folder C:\BLViewData.

More Information

‣ NetCDF Files (page 41)

8.3.1 Changing Storage Location of netCDF Files
You can change the location where BL-View stores the netCDF files.

1. On your computer, go to the following folder: 
C:\Program Files (x86)\Vaisala\BL-View\config

2. Open the file bl_calc_srv.ini in Notepad and edit the path information. The
default path is C:\BLViewData:

;NetCDF File Path
PATH=[S]"C:\BLViewData"
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3. Save and close the file.

4. To open command prompt, select Start, right-click on Command Prompt and select
Run as administrator.

5. In command prompt, to go to the main level, type the following: 

cd C:\

6. To go to the folder that contains the application for restarting the service, type the
following: 

cd C:\Program Files (x86)\Vaisala\BL-View\bin

7. Restart the service by typing the following: 

roaadmin.exe reload

More Information

‣ NetCDF Files (page 41)
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9. Managing Ceilometers
BL-View offers a connection to the ceilometer using the IO Terminal. IO Terminal connects to
the ceilometer through the communication port.

When the IO Terminal connection to the ceilometer is open, no ceilometer data is sent to
BL-View.

More Information

‣ Configuring Ceilometer (page 25)

9.1 Opening Terminal Connection
Use the terminal connection to connect to the ceilometer.

1. In BL-View, select IO terminal.
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2. In the Connection control panel, select Connect and in the Warning window, select OK.

The connection opens. The status bar displays the connection status.
If the ceilometer is in auto-send mode, the messages appear in the Terminal panel.

When the IO Terminal connection to the ceilometer is open, the
ceilometer does not send data to BL-View.
CAUTION!

9.1.1 Modifying Terminal Display Settings
You can modify the terminal settings with the selections in the Settings frame of the
Terminal panel. The settings define the way sensor messages and commands are displayed
in the Terminal panel.

• Select Visible symbols for binary to show the non-printable characters (binary values)
as symbols.

• Select VT100, if you wish the application to emulate a VT100 terminal.
• Select Local echo to display the commands you type in the Terminal panel on the

screen. In this case, the commands may be shown on the screen twice: once by your
workstation and once by the field device.

• Select CRLF Mode to make the system insert the carriage return (CR) and line feed (LF)
characters after each message line.

• Select Auto LF to make the system insert a new line on the screen after each message
line that is received from the field device. This makes it easier to read the field device
messages.

• Select Auto wrap to make the system start a new line on the screen after 80 characters.
This way you can see all text on the screen without having to scroll.
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9.2 Opening and Closing Communication
Port

The communication port that is used in serial communication has the following 2 internal
states:

• CLOSED: This is the transmitting state of a measurement data message. In this state,
messages are transmitted. User commands are not accepted, except for the open
command, which turns the line into the open state.

• OPEN: This is the user dialog state. In this state, the device responds to user commands
and command input is echoed. No automatic transmission of the measurement data
message is executed in the open state.

1. Open the connection to the ceilometer. See 9.1 Opening Terminal Connection (page 75).

2. To open the communication port to the ceilometer, type open in the Terminal panel
and press ENTER. 
The command mode starts, and the following command prompt is displayed on the
screen:

CEILO >

The ceilometer is ready for command input from the user.
For the complete list of commands, see Vaisala Ceilometer CL31 User Guide and Vaisala
Ceilometer CL51 User Guide.

3. To close the communication port to the ceilometer, type close in the Terminal panel
and press ENTER.

The data messages from the ceilometer are shown in the Terminal panel.

9.3 Logging Data
You can log data from the IO Terminal to a directory.

1. To start logging data to a temporary directory, select Log > Log to file. 
The directory is defined by the user's TMP environment variable.

2. To add timestamps at the beginning of each line, select Log > If logging use 
timestamps. 

Logging ends automatically when you close the IO terminal.

Chapter 9 – Managing Ceilometers

77



9.4 Saving Ceilometer Messages
For troubleshooting purposes, you can save or print the ceilometer messages and the sent
commands that are shown in the Terminal panel.

1. To copy all text from the Terminal panel, right-click the Terminal panel and select Copy.

2. Open a text editor, such as Windows Notepad, select Edit > Paste and save the file.

3. To print all text from the Terminal panel, select Print.

9.5 Closing Terminal Connection

When the IO Terminal connection to the ceilometer is open, the ceilometer
does not send data to BL-View.
CAUTION!

Close the terminal connection to the ceilometer. Closing the connection resumes ceilometer
data logging in BL-View.

1. In IO terminal, select Disconnect. 
The connection closes. The status bar displays the connection status.

9.6 Closing IO Terminal
To close IO Terminal, select File > Exit .
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10. Troubleshooting
To access the BL-View alerts, select Status.

To view ceilometer alerts in BL-View, select IO terminal.

10.1 Viewing BL-View Alerts
To access the BL-View alerts, select Status.

The Status icon is:

• Green when everything is working normally.
• Yellow when there is 1 alarm, warning, or notification.
• Red when there are open alarms or warnings.

BL-View reports alarms and warnings about the following issues:

• BL-View software
• Ceilometer status
• Interface between the ceilometer and BL-View
• RX platform

Table 16 BL-View Alarms and Warnings

Status Message Info Status Reason Instructions

Sensor data message interval
is not optimal for BL-View (16
or 36 seconds)

Warning Selected sensor data message
sending frequency is not
optimal (16 or 36 seconds).

Set the message interval to
optimal according to the
ceilometer type:

• CL31: 16 seconds
• CL51: 36 seconds

MISSING CEILOMETER
DATA

Alarm Sensor is not connected. Check that IO terminal
connection to the ceilometer
has been disconnected.
Change if necessary.

Alarm Sensor communication
settings are not correct.

Check that the communication
settings of the ceilometer and
BL-View match.

PORT ERROR Alarm BL-View cannot open the
serial port.

Make sure that the computer
has the corresponding serial
port. If you are using a USB
extender, verify that it is
connected, working properly,
and not reserved by another
application.
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Status Message Info Status Reason Instructions

Unable to parse ceilometer
data message

Alarm BL-View cannot parse the
ceilometer message.

Check that the message type
selected in BL-View
communication settings
matches the ceilometer
settings. Change if necessary.

REMOTE OBJECT MONITOR
FAULT DETECTED BY
SERVER A

Alarm RX platform error. Contact Vaisala technical
support.

OBJECT INFORMATION
CONFLICT DETECTED BY
SERVER A

ERROR WHEN READING
FILES LISTED IN
ROAPERS.INI ON SERVER
A
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10.2 Viewing Ceilometer Alerts
1. To view ceilometer alerts in BL-View, select IO terminal. 

Table 17 Ceilometer Status, Warnings

Status Message Info Reason Instructions

Window contamination warning
(appears from time to time and
lasts < 5 min)

Usually drizzle drops on the
window.

The blower cleans the window. If
clouds are detected, the height
information is correct. If no
clouds are detected, it is possible
that high clouds are missed.

Window contamination warning
(continuous)

For example, bird droppings,
leaves, or dust have
contaminated the window.

Clean the window.

Battery low warning The unit has been powered too
long using the backup battery.

Connect the line voltage or
replace the battery.

Battery fails to recharge. If the battery is old, replace it. If
the battery is OK, check the
operation of Ceilometer Engine
Board CLE321.

Transmitter expires warning Laser diode is too old. Replace Transmitter CLT321. The
measurement data is valid, but it
is possible that some clouds are
missed.

High humidity warning (option) Relative humidity > 85 %. Water
has been condensed inside the
ceilometer. Leakage in the
enclosure or leakage in the door.

Take the ceilometer inside, open
the maintenance door and let it
dry in a warm air conditioned
place. Condensed water on
optical surface may disturb the
measurement. There is a danger
of short circuits.

Blower failure warning Blower cable is not connected. Check that the blower cable is
connected.

Window blower circuit breaker is
not ON.

Check that the window blower
circuit breaker is ON.

Line voltage level is not correct. Check that the line voltage is
present and correct.

Blower is stuck. Check if visible obstacles disable
blower operation.

Blower is damaged. Replace the blower.

Blower is blowing, but only cool
air. The blower heater is
malfunctioning.

Replace the blower.

Chapter 10 – Troubleshooting

81



Status Message Info Reason Instructions

Humidity sensor failure warning
(option)

Humidity sensor is not
connected.

Connect the humidity sensor or
disable the option in the
software.

Humidity sensor is damaged. Contact technical support and
send the Vaisala Ceilometer to
Service Center for the humidity
sensor to be replaced.

Heater fault warning Window blower circuit breaker is
not ON.

Check that the window blower
circuit breaker is ON.

Line voltage level is not correct. Check that the line voltage is
present and correct.

Heater is damaged. Replace the heater.

High background radiance
warning

Direct sunlight. In case there are no alarms, the
measurements are OK. If there is
an alarm, the measurements are
invalid.

Ceilometer engine board failure
warning

Non-critical fault in ceilometer
engine board CLE321.

Replace ceilometer engine board
CLE321.

Battery failure warning Battery is dead. Replace the battery.

Laser monitor failure warning Laser power monitor board
CLM311 has failed.

Replace CLM311.

Laser power measurement on
Ceilometer Engine board CLE321
has failed.

Replace CLE321.

Receiver warning A non-critical CLR321 Receiver
failure.

Replace CLR321.

Tilt angle > 45° warning The unit is not correctly installed
or the tilt angle is larger than 45°.

Check the installation. The height
measurement accuracy is lost
with tilt angles greater than 45°.

Table 18 Ceilometer Status, Alarms

Problem Reason Instructions

Transmitter shut-off alarm (Laser
temperature > 85 °C)

Direct sunlight has heated the
laser.

Wait for the sun to exit the field-
of-view. The Vaisala Ceilometer
returns to normal operation.

Environment temperature is too
high.

Check if there is a specific reason
for the high temperature.

Transmitter failure alarm Laser is worn out or damaged. Replace Laser Transmitter
CLT321.

Laser does not get electrical
power.

Check from the status message
that the line Voltages is marked
OK.
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Problem Reason Instructions

Receiver failure alarm Receiver CLR321 is damaged. Replace CLR321.

Loose cable connection. Check that the cables from
Receiver CLR321 and Ceilometer
Optics CLO321 are undamaged
and correctly connected.

Receiver test not operating. Check that the Optics unit
CLO321 is not misplaced or
damaged. If the CLO321 unit is
damaged or missing, contact
Vaisala for repair and
replacement, since the CLO321
unit is not field replaceable.

Voltage failure alarm Ceilometer Engine Board CLE321
is damaged.

Replace CLE321.

Memory error alarm A failure in the CLE321 memory. Replace CLE321.

Light path obstruction alarm Window is badly contaminated
or severely scratched.

Clean the window or in case of
damage, replace CLW311.

Something blocks the laser
beam.

Check the clarity of the optical
path.

Receiver saturation alarm Direct sunlight. Wait for the sun to exit the field-
of-view. The Vaisala Ceilometer
returns to normal operation.

Something is partially blocking
the laser beam.

Check the clarity of the optical
path.

COAXIAL CABLE FAILURE Coaxial cable disconnected or
broken.

Verify the connection or replace
the coaxial cable.

CEILOMETER ENGINE BOARD
FAILURE

Ceilometer Engine board is
damaged.

Replace CLE321.

10.3 Writing Problem Report
When troubleshooting the product, write a problem report including:

• What failed (what worked / did not work)?
• Where did it fail (location and environment)?
• When did it fail (date, immediately / after a while / periodically/ randomly)?
• How many failed (only one defect / other same or similar defects/ several failures in

one unit)?
• What was done when the failure was noticed?
• What was connected to the product and to which connectors?
• Input power source type, voltage, and list of other items (such as lighting, heaters, and

motors) that were connected to the same power output.
• Are all parts connected and grounded properly? Take a photo to help troubleshooting.
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Appendix A. NetCDF Example
File
NetCDF L3 Example File: Default Parameters

{
dimensions:
    time = UNLIMITED ; // (3 currently)
    name = 1 ;
    date_stamp = 1 ;
    period = 1 ;
    cloud_status = 1 ;
    cloud_data = 3 ;
    bl_height_length = 1 ;
    bl_index = 3 ;
    bl_height = 3 ;
    Bs_prof_length = 1 ;
    Ng_prof_length = 1 ;
    Ec_prof_length = 1 ;
    Ec_prof_range = 1 ;
    Ec_prof_opacity = 1 ;
    vrb_height_averaging = 1 ;
    vrb_time_averaging = 1 ;
    Height_averaging_param = 1 ;
    Time_averaging_period = 1 ;
    algorithm_sensitivity = 1 ;
    boundary_layer_min = 1 ;
    boundary_layer_max = 1 ;
    number_of_boundary_layers = 1 ;
    Location_latitude = 1 ;
    Location_longitude = 1 ;
    location_utc_offset = 1 ;
    Alogrithm_Method = 1 ;
    parameter_key = 1 ;
    sunrise_utc = 1 ;
    sunset_utc = 1 ;
    range = 450 ;
variables:
    int time(time) ;
        time:Units = "days since 1970-01-01 00:00:00.000" ;
        time:Type = "double" ;
        time:Dimension = "time" ;
        time:axis = "T" ;
    string name(time, name) ;
    string date_stamp(time, date_stamp) ;
    int period(time, period) ;
    int cloud_status(time, cloud_status) ;
    int cloud_data(time, cloud_data) ;
    int bl_height_length(time, bl_height_length) ;
    int bl_index(time, bl_index) ;
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    int bl_height(time, bl_height) ;
    int Bs_prof_length(time, Bs_prof_length) ;
    int Bs_profile_data(time, range) ;
    int Ng_prof_length(time, Ng_prof_length) ;
    int Ng_profile_data(time, range) ;
    int Ec_prof_length(time, Ec_prof_length) ;
    int Ec_profile_data(time, range) ;
    int Ec_prof_range(time, Ec_prof_range) ;
    int Ec_prof_opacity(time, Ec_prof_opacity) ;
    int vrb_height_averaging(time, vrb_height_averaging) ;
    int vrb_time_averaging(time, vrb_time_averaging) ;
    int Height_averaging_param(time, Height_averaging_param) ;
    int Time_averaging_period(time, Time_averaging_period) ;
    int algorithm_sensitivity(time, algorithm_sensitivity) ;
    int boundary_layer_min(time, boundary_layer_min) ;
    int boundary_layer_max(time, boundary_layer_max) ;
    int number_of_boundary_layers(time, number_of_boundary_layers) ;
    float Location_latitude(time, Location_latitude) ;
    float Location_longitude(time, Location_longitude) ;
    float location_utc_offset(time, location_utc_offset) ;
    int Alogrithm_Method(time, Alogrithm_Method) ;
    string parameter_key(time, parameter_key) ;
    float sunrise_utc(time, sunrise_utc) ;
    float sunset_utc(time, sunset_utc) ;
    int range(range) ;

// global attributes:
        :site_location = "DEVICE_1" ;
data:

 time = 1476959616, 1476959632, 1476959648 ;

 name =
  "DEVICE_1",
  "DEVICE_1",
  "DEVICE_1" ;

 date_stamp =
  "2016-10-20-10:33:36",
  "2016-10-20-10:33:52",
  "2016-10-20-10:34:08" ;

 period =
  16,
  16,
  16 ;

 cloud_status =
  0,
  0,
  0 ;

 cloud_data =
  -999, -999, -999,
  -999, -999, -999,
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  -999, -999, -999 ;

 bl_height_length =
  1,
  1,
  1 ;

 bl_index =
  3, -999, -999,
  3, -999, -999,
  3, -999, -999 ;

 bl_height =
  380, -999, -999,
  380, -999, -999,
  380, -999, -999 ;

 Bs_prof_length =
  450,
  450,
  450 ;

 Bs_profile_data =
  852, 816, 765, 709, 660, 625, 590, 557, 523, 506, 491, 495, 503, 512, 522, 
    532, 542, 554, 566, 574, 568, 569, 568, 568, 568, 571, 577, 578, 574, 
    567, 544, 534, 524, 515, 505, 493, 479, 462, 444, 425, 419, 407, 398, 
    395, 393, 393, 390, 388, 387, 383, 386, 384, 381, 381, 381, 380, 377, 
    374, 373, 369, 365, 364, 361, 360, 360, 357, 357, 352, 348, 351, 349, 
    348, 346, 343, 343, 347, 348, 342, 343, 343, 345, 343, 342, 340, 335, 
    332, 331, 333, 335, 330, 326, 318, 313, 320, 325, 323, 320, 315, 307, 
    309, 310, 306, 300, 303, 300, 296, 300, 297, 291, 292, 287, 288, 282, 
    280, 274, 272, 267, 262, 260, 258, 251, 242, 236, 239, 236, 239, 242, 
    236, 229, 232, 234, 233, 235, 233, 228, 217, 205, 200, 204, 207, 199, 
    200, 195, 196, 194, 184, 180, 186, 198, 199, 201, 204, 202, 198, 192, 
    183, 171, 161, 159, 152, 143, 136, 128, 119, 109, 102, 87, 72, 67, 64, 
    66, 62, 56, 39, 20, 21, 16, 5, -2, -16, -26, -29, -35, -42, -54, -62, 
    -58, -45, -42, -47, -47, -44, -38, -42, -46, -48, -47, -43, -45, -40, 
    -36, -35, -38, -30, -23, -22, -13, -13, -17, -13, -4, 15, 13, 16, 17, 21, 
    29, 37, 36, 45, 38, 37, 31, 15, -7, -20, -30, -48, -66, -85, -81, -89, 
    -105, -97, -99, -98, -112, -132, -113, -100, -114, -112, -110, -122, 
    -127, -122, -120, -136, -166, -186, -200, -204, -205, -200, -197, -202, 
    -208, -209, -208, -195, -204, -217, -211, -210, -202, -184, -147, -132, 
    -119, -108, -114, -95, -99, -106, -94, -108, -107, -109, -96, -99, -99, 
    -121, -119, -118, -124, -123, -128, -114, -93, -83, -89, -104, -90, -60, 
    -31, -28, -44, -33, -13, -29, -7, -3, -14, -37, -45, -48, -52, -66, -83, 
    -62, -47, -47, -51, -38, 1, -3, 12, 21, 38, 27, 7, 29, 48, 86, 114, 111, 
    87, 83, 85, 48, 16, -40, -56, -35, -25, -17, -11, -19, 15, 40, 55, 64, 
    53, 82, 96, 109, 60, 11, 10, 11, -38, -66, -45, -60, -56, -35, -36, -83, 
    -108, -118, -132, -162, -186, -184, -181, -156, -112, -103, -84, -87, 
    -112, -126, -138, -164, -207, -270, -289, -308, -367, -376, -402, -439, 
    -462, -439, -397, -363, -342, -313, -286, -323, -355, -398, -431, -460, 
    -439, -432, -388, -380, -398, -414, -423, -444, -498, -502, -481, -460, 
    -475, -480, -496, -533, -496, -462, -446, -472, -559, -582, -583, -573, 
    -562, -556, -607, -601, -619, -632, -655, -697, -695, -657, -605, -605, 
    -596, -573, -572, -625, -654, -651, -632, -627, -627, -596, -626, -687, 
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    -724, -710, -711, -705, -669, -708, -736, -739,
  841, 807, 757, 702, 655, 621, 588, 555, 522, 506, 492, 496, 505, 514, 523, 
    533, 543, 554, 566, 573, 566, 567, 566, 565, 565, 568, 573, 575, 571, 
    563, 541, 531, 522, 512, 502, 490, 476, 459, 441, 424, 418, 406, 397, 
    394, 393, 393, 390, 388, 387, 384, 386, 384, 381, 381, 382, 381, 378, 
    375, 374, 369, 365, 363, 359, 358, 358, 355, 355, 350, 347, 349, 348, 
    348, 345, 341, 339, 343, 343, 338, 340, 340, 342, 340, 339, 337, 333, 
    330, 330, 330, 333, 328, 323, 316, 310, 315, 319, 318, 316, 312, 303, 
    306, 307, 302, 297, 299, 296, 292, 295, 293, 285, 286, 283, 284, 276, 
    275, 269, 266, 261, 256, 254, 255, 250, 241, 235, 238, 237, 240, 242, 
    236, 230, 233, 237, 236, 235, 233, 228, 217, 204, 200, 207, 211, 205, 
    206, 200, 202, 201, 189, 185, 191, 203, 207, 206, 209, 205, 200, 195, 
    187, 175, 164, 161, 152, 144, 136, 130, 121, 111, 102, 87, 75, 70, 69, 
    71, 68, 61, 45, 27, 26, 20, 7, -1, -15, -25, -25, -31, -40, -53, -62, 
    -56, -43, -41, -45, -47, -45, -38, -42, -43, -48, -45, -41, -40, -34, 
    -34, -34, -35, -30, -24, -24, -20, -22, -26, -20, -13, 2, 1, 3, 4, 12, 
    23, 28, 27, 35, 29, 28, 22, 5, -16, -26, -35, -53, -72, -90, -85, -94, 
    -106, -97, -100, -104, -121, -137, -118, -107, -120, -117, -113, -121, 
    -123, -120, -125, -143, -168, -186, -200, -205, -208, -207, -201, -205, 
    -208, -206, -205, -194, -202, -213, -207, -202, -196, -178, -142, -130, 
    -116, -106, -116, -102, -107, -111, -101, -113, -108, -108, -98, -102, 
    -103, -128, -125, -121, -126, -127, -133, -116, -89, -82, -90, -107, -93, 
    -65, -41, -37, -53, -44, -31, -49, -26, -19, -29, -55, -58, -62, -70, 
    -81, -94, -75, -62, -62, -67, -56, -15, -19, -6, 1, 17, 8, -11, 13, 35, 
    66, 88, 84, 61, 61, 64, 31, -3, -56, -68, -45, -36, -30, -23, -35, -2, 
    26, 37, 41, 31, 53, 67, 84, 32, -13, -13, -11, -61, -89, -69, -78, -76, 
    -56, -56, -100, -127, -144, -157, -180, -203, -197, -196, -176, -141, 
    -132, -115, -124, -150, -164, -168, -190, -235, -297, -322, -337, -386, 
    -391, -414, -452, -482, -456, -416, -383, -360, -335, -311, -341, -376, 
    -418, -444, -469, -444, -430, -384, -366, -390, -414, -429, -443, -491, 
    -491, -467, -443, -460, -468, -481, -524, -486, -446, -435, -449, -534, 
    -568, -574, -557, -546, -540, -589, -585, -608, -630, -656, -690, -690, 
    -660, -603, -601, -591, -580, -587, -639, -673, -667, -643, -635, -641, 
    -613, -646, -709, -747, -729, -725, -718, -680, -729, -762, -760,
  831, 798, 749, 696, 650, 617, 585, 553, 521, 506, 492, 497, 506, 515, 525, 
    534, 544, 555, 565, 572, 565, 565, 564, 563, 563, 565, 570, 571, 567, 
    560, 537, 527, 519, 509, 499, 488, 474, 458, 440, 424, 418, 406, 399, 
    396, 394, 394, 392, 389, 388, 386, 388, 386, 383, 383, 384, 383, 380, 
    376, 375, 371, 367, 366, 362, 361, 361, 358, 357, 353, 349, 351, 349, 
    349, 345, 341, 338, 342, 343, 338, 339, 340, 343, 341, 339, 338, 334, 
    330, 330, 331, 334, 330, 325, 317, 312, 316, 319, 319, 317, 314, 307, 
    310, 310, 306, 301, 302, 298, 295, 296, 293, 287, 288, 286, 286, 280, 
    278, 272, 268, 263, 258, 256, 257, 255, 247, 241, 244, 242, 242, 244, 
    238, 231, 234, 237, 235, 236, 234, 228, 216, 206, 203, 210, 211, 205, 
    204, 198, 198, 197, 186, 180, 185, 196, 199, 198, 201, 195, 187, 179, 
    172, 161, 150, 148, 140, 131, 123, 116, 107, 99, 89, 72, 56, 51, 53, 55, 
    51, 44, 28, 12, 12, 5, -6, -13, -24, -32, -33, -37, -46, -59, -68, -60, 
    -47, -47, -51, -50, -47, -41, -45, -46, -52, -48, -45, -42, -35, -33, 
    -34, -36, -28, -19, -17, -14, -16, -22, -16, -10, 4, 2, 4, 3, 11, 22, 29, 
    26, 33, 31, 32, 27, 9, -10, -18, -27, -45, -64, -80, -75, -84, -93, -88, 
    -90, -96, -116, -130, -110, -97, -111, -108, -107, -114, -115, -111, 
    -117, -134, -156, -172, -186, -190, -194, -194, -188, -190, -193, -192, 
    -194, -185, -193, -203, -196, -190, -184, -168, -132, -119, -107, -96, 
    -108, -98, -98, -98, -90, -101, -95, -94, -86, -90, -93, -121, -118, 
    -111, -117, -120, -125, -103, -70, -65, -74, -90, -72, -43, -23, -14, 
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    -30, -24, -15, -33, -11, -4, -13, -40, -41, -48, -62, -71, -81, -67, -56, 
    -57, -67, -58, -20, -23, -12, -4, 11, 2, -18, 4, 28, 54, 66, 59, 39, 37, 
    38, 3, -34, -83, -94, -71, -60, -53, -48, -66, -34, -1, 5, 9, 0, 19, 34, 
    56, 5, -34, -28, -24, -69, -94, -80, -90, -92, -73, -71, -111, -135, 
    -149, -157, -177, -206, -200, -202, -188, -161, -149, -135, -150, -179, 
    -194, -195, -218, -260, -321, -352, -364, -410, -411, -433, -472, -508, 
    -481, -448, -422, -407, -382, -354, -368, -400, -436, -458, -482, -455, 
    -435, -391, -370, -392, -416, -432, -437, -480, -472, -452, -430, -444, 
    -448, -462, -503, -467, -421, -408, -417, -501, -539, -547, -523, -513, 
    -505, -557, -555, -577, -597, -628, -665, -669, -647, -594, -589, -581, 
    -580, -594, -648, -687, -682, -655, -647, -659, -634, -670, -727, -764, 
    -747, -744, -734, -701, -745, -786, -788 ;

 Ng_prof_length =
  450,
  450,
  450 ;

 Ng_profile_data =
  -384, -363, -349, -337, -312, -281, -238, -189, -138, -90, -46, -6, 29, 55, 
    66, 69, 61, 51, 44, 39, 33, 26, 15, 0, -14, -27, -39, -48, -62, -78, -98, 
    -121, -137, -150, -153, -150, -144, -134, -129, -124, -119, -112, -99, 
    -86, -69, -55, -43, -32, -27, -24, -25, -27, -28, -28, -28, -27, -27, 
    -28, -30, -31, -32, -33, -34, -34, -33, -30, -28, -25, -23, -22, -20, 
    -20, -21, -22, -24, -23, -20, -19, -21, -25, -29, -29, -26, -23, -24, 
    -29, -32, -34, -37, -37, -40, -43, -43, -44, -44, -42, -42, -43, -45, 
    -50, -54, -57, -58, -56, -57, -61, -67, -75, -80, -81, -77, -74, -73, 
    -73, -73, -72, -68, -66, -69, -75, -83, -89, -91, -89, -87, -87, -86, 
    -84, -86, -86, -82, -78, -69, -61, -56, -51, -47, -48, -55, -63, -74, 
    -85, -90, -96, -103, -109, -117, -129, -143, -154, -161, -163, -158, 
    -156, -162, -170, -178, -187, -190, -196, -206, -210, -215, -219, -227, 
    -239, -250, -255, -253, -249, -244, -238, -230, -219, -211, -204, -199, 
    -193, -185, -175, -164, -153, -141, -127, -113, -100, -89, -82, -78, -69, 
    -56, -38, -21, -5, 5, 16, 30, 44, 57, 69, 79, 87, 91, 85, 70, 52, 34, 18, 
    3, -14, -27, -36, -44, -47, -51, -56, -60, -71, -76, -79, -83, -81, -87, 
    -96, -101, -106, -111, -121, -138, -162, -187, -205, -219, -228, -232, 
    -237, -240, -243, -244, -235, -223, -210, -196, -184, -169, -144, -115, 
    -86, -55, -33, -20, -9, -2, 6, 15, 12, 11, 5, 4, 11, 17, 16, 13, 12, 15, 
    31, 48, 66, 84, 97, 106, 108, 110, 118, 135, 152, 163, 172, 177, 180, 
    189, 188, 172, 151, 120, 90, 72, 56, 41, 37, 34, 42, 52, 58, 71, 80, 93, 
    111, 126, 138, 143, 146, 151, 164, 183, 194, 194, 191, 183, 161, 129, 79, 
    32, 5, -9, -3, -1, -5, 5, 21, 47, 79, 98, 116, 136, 150, 151, 128, 99, 
    68, 32, 2, -27, -60, -73, -73, -70, -77, -93, -128, -179, -219, -249, 
    -264, -269, -252, -216, -165, -105, -67, -57, -69, -93, -117, -150, -201, 
    -255, -312, -361, -398, -437, -481, -506, -504, -481, -438, -383, -333, 
    -291, -263, -262, -291, -330, -358, -366, -354, -319, -279, -250, -229, 
    -225, -243, -286, -328, -367, -388, -383, -371, -362, -361, -342, -302, 
    -251, -200, -176, -179, -185, -178, -155, -133, -140, -166, -210, -261, 
    -300, -334, -350, -335, -286, -229, -183, -154, -156, -181, -206, -230, 
    -236, -221, -189, -153, -137, -148, -178, -212, -230, -216, -197, -201, 
    -220, -244, -246, -226, -196, -176, -181, -194, -192, -190, -178, -160, 
    -149, -121, -98, -94, -121, -164, -214, -262, -274, -293,
  -372, -352, -337, -326, -302, -272, -230, -182, -132, -86, -43, -4, 30, 55, 
    65, 66, 58, 47, 40, 35, 29, 22, 11, -2, -16, -28, -39, -49, -62, -78, 
    -98, -120, -136, -148, -151, -147, -141, -132, -127, -121, -116, -108, 
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    -96, -82, -67, -53, -41, -30, -25, -23, -23, -26, -28, -29, -30, -29, 
    -29, -30, -32, -33, -33, -34, -35, -37, -37, -35, -33, -29, -27, -25, 
    -22, -21, -22, -22, -24, -23, -21, -20, -22, -26, -31, -32, -30, -26, 
    -25, -29, -31, -34, -37, -37, -40, -44, -44, -45, -46, -45, -45, -46, 
    -48, -53, -56, -60, -62, -60, -59, -61, -65, -71, -76, -77, -73, -70, 
    -70, -69, -69, -67, -63, -60, -64, -71, -79, -84, -84, -81, -77, -76, 
    -76, -73, -75, -75, -71, -66, -57, -50, -47, -45, -43, -44, -51, -60, 
    -72, -84, -90, -96, -102, -109, -118, -130, -143, -152, -158, -158, -153, 
    -151, -156, -165, -176, -187, -192, -200, -210, -214, -218, -221, -229, 
    -243, -254, -259, -257, -251, -246, -241, -233, -223, -213, -205, -199, 
    -192, -184, -172, -161, -151, -139, -127, -114, -103, -95, -92, -90, -83, 
    -70, -54, -37, -21, -10, 2, 19, 33, 46, 58, 67, 76, 81, 74, 60, 42, 26, 
    12, -2, -19, -33, -42, -49, -51, -55, -61, -68, -80, -85, -87, -89, -87, 
    -89, -95, -95, -97, -102, -113, -131, -153, -176, -194, -210, -221, -227, 
    -233, -235, -234, -234, -224, -211, -199, -186, -173, -158, -133, -104, 
    -76, -47, -28, -17, -8, -2, 6, 14, 12, 12, 8, 7, 13, 15, 11, 7, 8, 14, 
    30, 47, 64, 83, 100, 111, 113, 112, 116, 129, 144, 152, 159, 162, 161, 
    167, 164, 148, 129, 101, 72, 55, 42, 31, 29, 27, 34, 41, 45, 56, 64, 78, 
    98, 112, 124, 128, 131, 138, 151, 166, 173, 169, 165, 160, 143, 114, 68, 
    25, 0, -10, 0, 4, 0, 8, 23, 46, 76, 95, 108, 124, 138, 137, 115, 89, 60, 
    25, -4, -33, -64, -76, -74, -70, -78, -96, -132, -182, -220, -245, -257, 
    -261, -247, -215, -170, -117, -85, -79, -93, -118, -137, -166, -214, 
    -267, -323, -369, -399, -430, -469, -493, -493, -474, -433, -379, -330, 
    -289, -262, -262, -291, -328, -354, -359, -340, -299, -254, -221, -204, 
    -205, -226, -266, -302, -332, -345, -335, -321, -311, -315, -300, -261, 
    -211, -156, -130, -137, -149, -147, -126, -103, -106, -130, -176, -229, 
    -272, -309, -325, -312, -266, -211, -170, -147, -158, -193, -227, -253, 
    -255, -235, -202, -169, -160, -179, -213, -248, -264, -246, -223, -228, 
    -249, -278, -288, -268, -236, -215, -219, -234, -236, -235, -223, -202, 
    -187, -157, -134, -129, -158, -202, -254, -301, -314, -331,
  -362, -342, -328, -317, -294, -264, -223, -175, -126, -81, -39, -1, 31, 55, 
    64, 64, 55, 44, 37, 31, 25, 18, 8, -5, -19, -30, -41, -50, -63, -78, -97, 
    -118, -133, -145, -147, -143, -137, -127, -122, -117, -112, -104, -92, 
    -79, -64, -51, -38, -29, -25, -22, -23, -26, -27, -28, -28, -28, -28, 
    -29, -31, -33, -34, -35, -37, -39, -39, -37, -35, -31, -29, -27, -25, 
    -23, -24, -25, -26, -26, -23, -21, -23, -26, -31, -32, -29, -25, -24, 
    -26, -28, -30, -32, -33, -37, -41, -43, -44, -45, -44, -44, -44, -46, 
    -51, -55, -59, -61, -59, -59, -59, -62, -67, -71, -73, -71, -70, -71, 
    -71, -71, -70, -66, -63, -67, -73, -80, -84, -83, -81, -79, -80, -81, 
    -79, -82, -82, -79, -75, -66, -60, -58, -58, -59, -63, -72, -80, -90, 
    -100, -106, -111, -117, -123, -131, -143, -158, -169, -175, -176, -170, 
    -168, -175, -183, -193, -201, -205, -210, -218, -220, -221, -224, -230, 
    -242, -252, -257, -253, -246, -239, -232, -222, -211, -202, -195, -190, 
    -183, -174, -161, -150, -138, -126, -111, -96, -83, -73, -69, -68, -61, 
    -49, -35, -19, -5, 3, 14, 28, 41, 53, 64, 73, 83, 89, 83, 70, 53, 37, 23, 
    8, -8, -21, -29, -35, -37, -42, -49, -58, -72, -78, -80, -82, -81, -86, 
    -93, -93, -94, -98, -108, -124, -144, -165, -181, -195, -207, -213, -219, 
    -221, -221, -223, -215, -205, -195, -182, -170, -154, -130, -102, -75, 
    -48, -28, -18, -10, -2, 7, 17, 16, 16, 11, 11, 18, 20, 14, 8, 8, 12, 28, 
    43, 59, 81, 100, 113, 116, 116, 121, 135, 153, 163, 171, 173, 170, 172, 
    168, 153, 133, 107, 78, 59, 46, 34, 30, 27, 31, 34, 35, 43, 49, 62, 82, 
    98, 110, 114, 116, 122, 133, 142, 142, 132, 125, 118, 99, 68, 19, -24, 
    -47, -56, -44, -37, -41, -35, -20, 0, 30, 51, 63, 81, 97, 97, 80, 61, 39, 
    11, -11, -38, -68, -82, -83, -79, -86, -101, -133, -176, -206, -226, 
    -235, -239, -228, -198, -156, -106, -78, -76, -95, -121, -139, -166, 
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    -211, -263, -319, -365, -392, -420, -458, -484, -488, -477, -444, -400, 
    -361, -324, -294, -287, -305, -334, -357, -360, -341, -302, -258, -224, 
    -207, -206, -220, -253, -280, -302, -309, -296, -279, -266, -267, -253, 
    -214, -162, -104, -75, -82, -96, -96, -74, -48, -47, -67, -109, -156, 
    -198, -239, -263, -262, -228, -180, -145, -128, -145, -188, -230, -260, 
    -265, -248, -219, -193, -192, -214, -249, -283, -299, -283, -261, -267, 
    -291, -326, -341, -326, -297, -279, -284, -303, -308, -308, -299, -280, 
    -265, -237, -213, -204, -229, -271, -321, -365, -379, -393 ;

 Ec_prof_length =
  450,
  450,
  450 ;

 Ec_profile_data =
  5, 5, 5, 5, 4, 4, 4, 4, 4, 4, 4, 4, 4, 4, 5, 5, 5, 5, 5, 5, 5, 5, 5, 4, 4, 
    5, 5, 5, 5, 5, 5, 6, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0,
  5, 5, 5, 5, 5, 5, 4, 4, 4, 4, 4, 4, 4, 5, 5, 5, 5, 6, 5, 5, 5, 5, 5, 5, 5, 
    5, 6, 6, 6, 6, 6, 6, 6, 6, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0,
  5, 5, 5, 5, 5, 5, 4, 4, 4, 4, 4, 4, 4, 5, 5, 5, 6, 6, 6, 6, 5, 5, 5, 5, 5, 
    5, 6, 6, 6, 6, 6, 6, 6, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
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    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 
    0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0 ;

 Ec_prof_range =
  320,
  340,
  330 ;

 Ec_prof_opacity =
  14,
  16,
  16 ;

 vrb_height_averaging =
  1,
  1,
  1 ;

 vrb_time_averaging =
  1,
  1,
  1 ;

 Height_averaging_param =
  360,
  360,
  360 ;

 Time_averaging_period =
  3120,
  3120,
  3120 ;

 algorithm_sensitivity =
  10,
  10,
  10 ;

 boundary_layer_min =
  30,
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  30,
  30 ;

 boundary_layer_max =
  4000,
  4000,
  4000 ;

 number_of_boundary_layers =
  3,
  3,
  3 ;

 Location_latitude =
  60.1699,
  60.1699,
  60.1699 ;

 Location_longitude =
  24.9384,
  24.9384,
  24.9384 ;

 location_utc_offset =
  -6,
  -6,
  -6 ;

 Alogrithm_Method =
  0,
  0,
  0 ;

 parameter_key =
  "1_360_1_3120_10_30_4000_3_0",
  "1_360_1_3120_10_30_4000_3_0",
  "1_360_1_3120_10_30_4000_3_0" ;

 sunrise_utc =
  5.310574,
  5.310574,
  5.310574 ;

 sunset_utc =
  14.85528,
  14.85528,
  14.85528 ;

 range = 10, 20, 30, 40, 50, 60, 70, 80, 90, 100, 110, 120, 130, 140, 150, 
    160, 170, 180, 190, 200, 210, 220, 230, 240, 250, 260, 270, 280, 290, 
    300, 310, 320, 330, 340, 350, 360, 370, 380, 390, 400, 410, 420, 430, 
    440, 450, 460, 470, 480, 490, 500, 510, 520, 530, 540, 550, 560, 570, 
    580, 590, 600, 610, 620, 630, 640, 650, 660, 670, 680, 690, 700, 710, 
    720, 730, 740, 750, 760, 770, 780, 790, 800, 810, 820, 830, 840, 850, 
    860, 870, 880, 890, 900, 910, 920, 930, 940, 950, 960, 970, 980, 990, 
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    1000, 1010, 1020, 1030, 1040, 1050, 1060, 1070, 1080, 1090, 1100, 1110, 
    1120, 1130, 1140, 1150, 1160, 1170, 1180, 1190, 1200, 1210, 1220, 1230, 
    1240, 1250, 1260, 1270, 1280, 1290, 1300, 1310, 1320, 1330, 1340, 1350, 
    1360, 1370, 1380, 1390, 1400, 1410, 1420, 1430, 1440, 1450, 1460, 1470, 
    1480, 1490, 1500, 1510, 1520, 1530, 1540, 1550, 1560, 1570, 1580, 1590, 
    1600, 1610, 1620, 1630, 1640, 1650, 1660, 1670, 1680, 1690, 1700, 1710, 
    1720, 1730, 1740, 1750, 1760, 1770, 1780, 1790, 1800, 1810, 1820, 1830, 
    1840, 1850, 1860, 1870, 1880, 1890, 1900, 1910, 1920, 1930, 1940, 1950, 
    1960, 1970, 1980, 1990, 2000, 2010, 2020, 2030, 2040, 2050, 2060, 2070, 
    2080, 2090, 2100, 2110, 2120, 2130, 2140, 2150, 2160, 2170, 2180, 2190, 
    2200, 2210, 2220, 2230, 2240, 2250, 2260, 2270, 2280, 2290, 2300, 2310, 
    2320, 2330, 2340, 2350, 2360, 2370, 2380, 2390, 2400, 2410, 2420, 2430, 
    2440, 2450, 2460, 2470, 2480, 2490, 2500, 2510, 2520, 2530, 2540, 2550, 
    2560, 2570, 2580, 2590, 2600, 2610, 2620, 2630, 2640, 2650, 2660, 2670, 
    2680, 2690, 2700, 2710, 2720, 2730, 2740, 2750, 2760, 2770, 2780, 2790, 
    2800, 2810, 2820, 2830, 2840, 2850, 2860, 2870, 2880, 2890, 2900, 2910, 
    2920, 2930, 2940, 2950, 2960, 2970, 2980, 2990, 3000, 3010, 3020, 3030, 
    3040, 3050, 3060, 3070, 3080, 3090, 3100, 3110, 3120, 3130, 3140, 3150, 
    3160, 3170, 3180, 3190, 3200, 3210, 3220, 3230, 3240, 3250, 3260, 3270, 
    3280, 3290, 3300, 3310, 3320, 3330, 3340, 3350, 3360, 3370, 3380, 3390, 
    3400, 3410, 3420, 3430, 3440, 3450, 3460, 3470, 3480, 3490, 3500, 3510, 
    3520, 3530, 3540, 3550, 3560, 3570, 3580, 3590, 3600, 3610, 3620, 3630, 
    3640, 3650, 3660, 3670, 3680, 3690, 3700, 3710, 3720, 3730, 3740, 3750, 
    3760, 3770, 3780, 3790, 3800, 3810, 3820, 3830, 3840, 3850, 3860, 3870, 
    3880, 3890, 3900, 3910, 3920, 3930, 3940, 3950, 3960, 3970, 3980, 3990, 
    4000, 4010, 4020, 4030, 4040, 4050, 4060, 4070, 4080, 4090, 4100, 4110, 
    4120, 4130, 4140, 4150, 4160, 4170, 4180, 4190, 4200, 4210, 4220, 4230, 
    4240, 4250, 4260, 4270, 4280, 4290, 4300, 4310, 4320, 4330, 4340, 4350, 
    4360, 4370, 4380, 4390, 4400, 4410, 4420, 4430, 4440, 4450, 4460, 4470, 
    4480, 4490, 4500 ;
}

More Information

‣ NetCDF Files (page 41)

BL-View User Guide M211185EN-B

94



Glossary

atmospheric boundary layer
Atmospheric boundary layer is the air layer near the ground affected by diurnal heat,
moisture, or momentum transfer to or from the surface.

backscatter
Backscatter is the reflection of waves, particles, or signals back to the direction from
which they came.

BL-View
See Vaisala Boundary Layer View Software.

boundary layer
Boundary layer is the air layer near the ground that is affected by diurnal heat,
moisture, or momentum transfer to or from the surface.

calculation preset
Calculation preset is a set of algorithm parameters that is used in plotting the
boundary layer.

cloud base
Cloud base is the lowest altitude of the visible portion of the cloud. Cloud base is
expressed either in meters or feet above mean sea level (or planetary surface), or as
the corresponding pressure level in hectopascal (hPa, equivalent to millibar).

IO Terminal
IO Terminal is terminal software that connects to sensors and other field devices
through a communication port.

mixing layer height
Mixing layer height is the height up to which atmospheric properties or substances
originating from the Earth’s surface are dispersed by turbulent vertical mixing
processes.

MLH
See mixing layer height (page 95).

planetary boundary layer
Planetary boundary layer is the lowest part of the atmosphere.

plot
Plot is a graphic representation of data in BL-View. There are archive and live plots.

Vaisala Boundary Layer View Software
Vaisala Boundary Layer View Software is an application that is used for planetary
boundary layer analysis.

Glossary
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Warranty
For standard warranty terms and conditions, see www.vaisala.com/warranty.

Please observe that any such warranty may not be valid in case of damage due to normal
wear and tear, exceptional operating conditions, negligent handling or installation, or
unauthorized modifications. Please see the applicable supply contract or Conditions of Sale
for details of the warranty for each product.

Technical Support

Contact Vaisala technical support at helpdesk@vaisala.com. Provide at least the following
supporting information:

• Product name, model, and serial number
• Name and location of the installation site
• Name and contact information of a technical person who can provide further

information on the problem

For more information, see www.vaisala.com/support.

Recycling

Recycle all applicable material.

Follow the statutory regulations for disposing of the product and packaging.
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